**Introduction**

The DHH805-A is a handheld terminal for device configuration of HART® instruments. It interfaces to a wide range of devices supporting ABB instruments with an option to support those from third party suppliers. All supported HART field devices can be configured, polled and trimmed using the Mobility DHH805.

**For more information**

Further publications for DHH805-A handheld communicator are available for free download from www.abb.com/pressure
The Company

We are an established world force in the design and manufacture of measurement products for industrial process control, flow measurement, gas and liquid analysis and environmental applications.

As a part of ABB, a world leader in process automation technology, we offer customers application expertise, service and support worldwide.

We are committed to teamwork, high quality manufacturing, advanced technology and unrivalled service and support.

The quality, accuracy and performance of the Company’s products result from over 100 years experience, combined with a continuous program of innovative design and development to incorporate the latest technology.
Table of contents

1. Introduction ................................................. 4
   1.1 Instruction manual structure ......................... 4
   1.2 Models covered by this manual ....................... 4
   1.3 Product description .................................... 4

2 Safety notes .................................................. 5
   2.1 General safety information ............................ 5
   2.2 Use of instruction ....................................... 5
   2.3 Qualified personnel ................................... 5
   2.4 Health and safety ..................................... 5
   2.5 Returning devices ..................................... 5
   2.6 Disposal .................................................. 6
   2.7 Information on WEEE ................................... 6
   2.8 Transport and storage .................................. 6
   2.9 Safety information for electrical installation ...... 6
   2.10 Contacting ABB ........................................ 6
   2.11 Conclusions ............................................ 6

3 DHH805-A overview ........................................... 7
   3.1 DHH805-A components overview ..................... 7
   3.2 DHH805-A display overview ............................ 8
      3.2.1 Symbols ............................................. 8
   3.3 Keypad Overview ........................................ 8

4 First steps .................................................... 9
   4.1 Opening the box ........................................ 9
   4.2 Preliminary inspection .................................. 9
   4.3 DHH805-A Start up procedures ........................ 9
   4.4 Activation procedure ................................... 10
      4.4.1 Activation via PC-Tool ............................. 10
      4.4.2 Manual activation .................................. 11
   4.5 Disclaimers .............................................. 11
      4.5.1 END-USER LICENSE AGREEMENT ............... 11
      4.5.2 Personal Data Handling Authorization .......... 13
      4.5.3 Data Acquisition and Handling Authorization .... 13

5 License upgrade ............................................. 14
   5.1 Overview ................................................ 14
   5.2 License upgrade procedure ............................ 14
      5.2.1 License upgrade via PC-Tool ...................... 14
      5.2.2 Manual upgrade ...................................... 14

6 General operation ........................................... 15
   6.1 Power options ........................................... 15
   6.2 Communication / AC adapter dongle .................. 15
   6.3 Navigating menus on the DHH805-A display .......... 15
   6.4 Turning the DHH805-A on ................................ 15
   6.5 DHH805-A settings ...................................... 16
      6.5.1 Settings ............................................. 16
      6.5.2 Communication ...................................... 16
   6.6 NiMh Battery Considerations ......................... 16

7 HART® communications ...................................... 17
   7.1 Overview ................................................ 17
   7.2 HART® Commands ...................................... 17
   7.3 HART® Connections .................................... 17
   7.4 Generic HART® Commands .............................. 18
   7.5 HART® Communication / Online Mode ................. 19
   7.6 Multidrop Poll (addresses 1 – 63) ..................... 19
   7.7 Offline menu mode ...................................... 19
      7.7.1 Configuration management - Edit ............... 20
      7.7.2 Configuration management - Create ............. 20
      7.7.3 Configuration management - Delete ............... 20
      7.7.4 Configuration management - Clone ............... 21
   7.8 Online menu mode ....................................... 21
   7.9 Device status warning .................................. 21
   7.10 Save / send configuration functions ................. 21
   7.11 DD Structure ............................................ 22
      7.11.1 266 Pressure Transmitter ......................... 22
      7.11.2 TTX200 Temperature Transmitter ............... 25
      7.11.3 FSM4000 Flow Transmitter ....................... 26
      7.11.4 EDP300 Positioner ................................ 31

8 PC-Tool ....................................................... 40
   8.1 Overview ................................................ 40
   8.2 Installation procedure .................................. 40
   8.3 PC-Tool homepage ....................................... 40
   8.4 Main tabs explanation .................................. 40
      8.4.1 File .................................................. 40
      8.4.2 Tools ................................................ 40
      8.4.3 Help .................................................. 41
   8.5 Troubleshooting ......................................... 43
   8.6 Prerequisites ............................................ 44
      8.6.1 Minimum System Requirements .................... 44
      8.6.2 Recommended System Requirements ................ 44
   8.7 Further information .................................... 44

9 Hazardous area considerations ............................ 45
   9.1 Intrinsically safe operations .......................... 45
   9.2 Intrinsic Safe Control Document ...................... 46
      9.2.1 Intrinsically safe FM Us and Canada Approved* .... 46
      9.2.2 Non Incendive FM Us and Canada Approved ...... 47
      9.2.3 Entity and Non-Incendive concepts ............... 48
1. Introduction

1.1 Instruction manual structure
The present manual provides information on operating and troubleshooting the hand held terminal DHH805-A. Every section in the present manual is dedicated to the specific phase of the life cycle starting from the receipt of the communicator and its identification, detailing activation process, connection to the instrument, configuration, troubleshooting, license upgrade, firmware update and maintenance operations.

1.2 Models covered by this manual
DHH805-A is the model number for the handheld product covered by this manual.

1.3 Product description
The Hand Held Communicator provides a smart interface with HART electronic devices: it is designed to enable the plant engineer to configure, calibrate and troubleshoot the transmitters either before or after field installation.

The Hand Held Communicator can store in its non-volatile memory hundreds of transmitter configurations.

The Communicator employs a four line by twenty dot matrix characters LCD and a 23 key tactile feedback keyboard.

The hand held terminal is based on standard Bell 202 FSK (Frequency Shift Keying) current modulation superimposed on the 4 to 20 mA analog signal: since the energy balance added to the current loop is virtually equal to zero no disturbence or interference occurs on the analog process signal.

This version of the Communicator, when powered by internal rechargeable batteries, is certified intrinsically safe for use in hazardous locations according to the standard printed label placed on the battery pack.
2 Safety notes

2.1 General safety information
The “Safety” section provides an overview of the safety aspects to be observed for operating the device.

The device has been constructed in accordance with the state of the art and is operationally safe. It has been tested and left the factory in perfect working conditions. The information in the manual, as well as the applicable documentation and certificates, must be observed and followed in order to maintain this condition throughout the period of operation.

Full compliance with the general safety requirements must be observed during operation of the device. In addition to the general information, the individual sections in the manual contain descriptions of processes or procedural instructions with specific safety information.

Only by observing all of the safety information can you reduce to the minimum the risk of hazards for personnel and/or environment. These instructions are intended as a comprehensive overview and do not contain detailed information on every conceivable event that may occur during setup, operation and maintenance work.

For additional information, or in the event of specific problems not covered in detail by these operating instructions, please contact the manufacturer. In addition, ABB declares that the contents of this manual are not part of any prior or existing agreements, commitments, or legal relationships; nor are they intended to amend these.

All obligations of ABB arise from the conditions of the relevant sales agreement, which also contains the solely binding warranty regulations in full. These contractual warranty provisions are neither extended nor limited by the information provided in this manual.

Read these instructions before starting installation; save these instructions for future reference.

2.2 Use of instruction

Danger – <Serious damage to health/risk to life>. This message indicates that an imminent risk is present. Failure to avoid this will result in death or serious injury.

Caution – <Minor injuries>. This message indicates a potentially dangerous situation. Failure to avoid this could result in minor injuries. This may also be used for property damage warnings.

Important. This message indicates indicates operator tips or particularly useful information. It does not indicate a dangerous or damaging situation.

Warning – <Bodily injury>. This message indicates a potentially dangerous situation. Failure to avoid this could result in death or serious injury.

Attention – <Property damage>. This message indicates a potentially damaging situation. Failure to avoid this could result in damage to the product or its surrounding area.

2.3 Qualified personnel
Operations on the device may only be performed by trained specialist personnel who have been authorized by the plant operator. The specialist personnel must have read and understood the manual and comply with its instructions.

Warning – <Possible process upsets>. Maintenance must be performed only by qualified personnel and only after securing equipment controlled by this product. Adjusting or removing this product while it is in the system may upset the process being controlled. Some process upsets may cause injury or damage.

2.4 Health and safety
To ensure that our products are safe and without risk to health, the following points must be noted:

— The relevant sections of these instructions must be read carefully before proceeding.
— Warning labels on containers and packages must be observed.
— Installation, operation, maintenance and servicing must only be carried out by suitably trained personnel and in accordance with the information given.
— Normal safety precautions must be taken to avoid the possibility of an accident occurring when operating in conditions of high pressure and/or temperature.
— Chemicals must be stored away from heat, protected from extreme temperatures
— When disposing of chemicals ensure that no two chemicals are mixed.

Safety advice concerning the use of the equipment described in this manual or any relevant hazard data sheets (where applicable) may be obtained from the Company address on the back cover, together with servicing and spares information.

2.5 Returning devices
Use the original packaging or suitably secure shipping package if you need to return the device for repair purposes. Fill out the return form (trouble sheet - see the end of the document) and include this with the device.

According to EC guidelines and other local laws for hazardous materials, the owner of hazardous waste is responsible for its disposal. The owner must observe the proper regulations for shipping purposes.

All devices sent back to ABB must be free from any hazardous materials (acids, alkalis, solvents, etc.). A Material Safety Data Sheet (MSDS) for all process liquids must accompany returned equipment (see the end of this document for the official form). Contact the factory for authorization prior to returning equipment.
2.6 Disposal

ABB actively promotes environmental awareness and has an operational management system that meets the requirements of EN ISO 9001:2015 and EN ISO 14001:2015. Our products and solutions are intended to have minimum impact on the environment and persons during manufacturing, storage, transport, use and disposal.

This includes the environmentally friendly use of natural resources. ABB conducts an open dialog with the public through its publications.

This product/solution is manufactured from materials that can be reused by specialist recycling companies.

2.7 Information on WEEE Directive 2012/19/EU (Waste Electrical and Electronic Equipment)

This product or solution is subject to the WEEE Directive 2012/19/EU or corresponding national laws. Starting from August 15th 2018, electrical and electronic equipment marked with the crossed-out wheeled bin symbol may not be disposed as unsorted municipal waste. Waste of electrical and electronic equipment (WEEE) shall be treated separately using the national collection framework available to customers for the return, recycling and treatment of WEEE.

Proper disposal prevents negative effects on people and the environment, and supports the reuse of valuable raw materials. ABB can accept and dispose of returns for a fee.

2.8 Transport and storage

— After unpacking, check the device for transport damage.
— Check the packaging material for accessories.
— During intermediate storage or transport, store the device in the original packaging only.

The duration of storage of the unused device is strictly related to the duration of the batteries (see paragraph 6.6 “Consideration about NiMh batteries).

Warranty conditions are stipulated on the order acknowledgment by the supplier.

2.9 Safety information for electrical installation

**Warning.** Electrical connections may only be established by authorized specialist personnel in accordance with the electrical circuit diagrams. The electrical connection information in the manual must be observed; otherwise, the applicable protection type may be affected.

2.10 Contacting ABB

Should assistance be required with any of the company’s products, contact the following:

— Telephone: +39 0344 58111
— Internet: www.abb.com

Select Instrumentation & Analytical from the Our Offerings section

Select Contact Directory from the Products & Services tab. Then select your country location from the Your Country drop-down menu in the center of the page.

Select Service from the Instrumentation & Analytical Product Group listing and complete the requested information in the pop-up window.

2.11 Conclusions

**Important.** The information contained in this document is subject to change without notice.

ABB SpA., its affiliates, employees, and agents, and the authors of and contributors to this publication specifically disclaim all liabilities and warranties, express and implied (including warranties of merchantability and fitness for a particular purpose), for the accuracy, currency, completeness, and/or reliability of the information contained herein and/or for the fitness for any particular use and/or for the performance of any material and/or equipment selected in whole or part with the user of or in reliance upon information contained herein. Selection of materials and/or equipment is at the sole risk of the user of this publication.

This document contains proprietary information of ABB SpA., and is issued in strict confidence. Its use, or reproduction for use, for the reverse engineering, development or manufacture of hardware or software described herein is prohibited. No part of this document may be photocopied or reproduced without the prior written consent of ABB SpA.
3 DHH805-A overview

3.1 DHH805-A components overview
DHH805-A is a full function HART® Communicator supporting Universal, Common Practice and Device Specific commands for commissioning, configuration and maintenance operations. HART® field devices can be configured, polled, and trimmed using the DHH805-A with HART® communications.

1 HART® connectors | 2 Protective plastic cover | 3 USB port | 4 Power supply unit connection | 5 Hand strap

Figure 1: DHH805-A overview

Important. For Intrinsically Safe applications, refer to the Hazardous Area Use section of this manual. For specific details on use of approved DHH805-A and applicable restrictions refer to Intrinsic Safety Control Drawings in Section 9 of this manual.
3.2 DH805-A display overview

The display of DH805-A is a 128 x 64 pixel graphic display with a backlight. Viewable area is 5.6 cm x 2.8 cm (2.2 in. x 1.1 in.) for 4 viewable message lines. The display provides three types of information:

- Header information including: menu or submenus titles, alpha or numeric entry mode indicator and battery level
- Main data display shows operating menus and submenus (editable parameters and device information included)
- Footer information defining: display navigation keys functionality (defined hereafter) as well as some defined operation icons (i.e.: information frames or uppercase lock).

3.2.1 Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Battery symbol" /></td>
<td>Battery symbol indicates DH805-A remaining portion of battery.</td>
</tr>
<tr>
<td><img src="image" alt="Electrical plug symbol" /></td>
<td>Electrical plug symbol indicates the AC adapter is connected and batteries are recharging.</td>
</tr>
<tr>
<td><img src="image" alt="ABC" /></td>
<td>This symbol indicates that the selected parameter can be edited with alphabetic characters</td>
</tr>
<tr>
<td><img src="image" alt="123" /></td>
<td>This symbol indicates that the selected parameter can be edited with numeric characters</td>
</tr>
<tr>
<td><img src="image" alt="Frames" /></td>
<td>The symbol here on the left indicates that the chosen submenus contain a list of selectable options.</td>
</tr>
<tr>
<td><img src="image" alt="Heart" /></td>
<td>This symbol appears on the bottom of the display and indicates that the device is performing HART commands and/or is communicating with a live connected HART instrument.</td>
</tr>
</tbody>
</table>

3.3 Keypad Overview

DH805-A keypad has three basic key types: single function keys, dual-function keys, and soft keys with changing definitions. The following table shows keys and their relevant meanings:

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="ON" /></td>
<td>ON. In order to power the HHT on, user has to keep this key pressed for five (5) seconds (until the backlight is on). The unit will display the ABB logo, the software revision number and ABB website address. The message “Polling…” will be briefly displayed: in this phase, the HHT scans the network according to its customized configuration (address 0 or polling mode) and then it provides the list of all the connected devices, if any. If at least one device with is found, the HHT immediately goes into online status and displays information about the device. If no device is found, the HHT Main navigation screen is shown.</td>
</tr>
<tr>
<td><img src="image" alt="OFF" /></td>
<td>OFF. To turn DH805 off, press and hold the OFF key for approximately five (5) seconds. The unit will display the message “Shutting down…”.</td>
</tr>
<tr>
<td><img src="image" alt="DISPLAY CONTRAST" /></td>
<td>DISPLAY CONTRAST. This key allows the user to adjust the contrast of the LCD display for ambient lighting and user preferences at any time and in any operating mode. Pressing and holding this key cycles through all available contrast settings. After adjusting Display Contrast, wait at least five (5) seconds before turning unit off to insure storage of new contrast setting.</td>
</tr>
<tr>
<td><img src="image" alt="BACKLIGHT" /></td>
<td>BACKLIGHT. This key toggles the backlight feature between Very low intensity / Low intensity / Mid intensity / High intensity to illuminate the display in poor ambient light conditions. Battery life is affected by use of the backlight feature; High intensity is the most aggressive. To disable backlight function access the dedicated menu entry under “Settings”</td>
</tr>
<tr>
<td><img src="image" alt="LEFT / RIGHT ARROW KEYS" /></td>
<td>LEFT / RIGHT ARROW KEYS. These keys support cursor movement forward and backward for text / numeric editing needs on customizable parameters. The default edit mode is “overwrite.”</td>
</tr>
<tr>
<td><img src="image" alt="DELETE / HELP" /></td>
<td>DELETE / HELP. This editing key will delete the character located on the left of the cursor in a text / numeric string while editing customizable parameters. The HELP function is performed during the device navigation only on some specific items. This function can be exploited only when a device is connected to the HHT. When available, the information icon will appear in the bottom center of the display.</td>
</tr>
<tr>
<td><img src="image" alt="LEFT NAVIGATION KEY" /></td>
<td>LEFT NAVIGATION KEY. This key has different meanings according to the menu or submenu user is navigating. It can mean: — Back: go back to the previous menu / submenu — Cancel: exit without saving the selected parameter value — No: as answer within some specific question frames</td>
</tr>
<tr>
<td><img src="image" alt="RIGHT NAVIGATION KEY" /></td>
<td>RIGHT NAVIGATION KEY. This key has different meanings according to the menu or submenu user is navigating. It can mean: — Edit: edit customizable parameters — Select: enter a submenu or select a parameter value in a list (enumeration) — Apply: apply the new entered value — Ok: save selected parameter and display stored parameter value — Yes: as answer within some specific question frames — On: for powering on the device for the first time before activation.</td>
</tr>
<tr>
<td><img src="image" alt="UP NAVIGATION KEY" /></td>
<td>UP NAVIGATION KEY. The up navigation key is useful when scrolling up/down a list (menu and submenus with their relevant entries). This key enables the writing in uppercase during the editing of customizable parameters (i.e.: change password). This key can also be used for scrolling up a long help message.</td>
</tr>
<tr>
<td><img src="image" alt="DOWN NAVIGATION KEY" /></td>
<td>DOWN NAVIGATION KEY. The down navigation key is useful when scrolling up/down a list (menu and submenus with their relevant entries). This key disables the writing in uppercase (if selected) during the editing of a customizable parameters (lowercase as default). This key can also be used for scrolling down a long help message.</td>
</tr>
<tr>
<td><img src="image" alt="ALPHA-NUMERIC KEYPAD" /></td>
<td>ALPHA-NUMERIC KEYPAD. All the keys are essential to insert alphabetic or numeric strings in all editable fields. Numbers (with the decimal point and the minus sign) are the only characters that can be written when editing numerical fields whereas within alphanumerical strings they always follow all the letters enabled for the pressed key.</td>
</tr>
</tbody>
</table>
4 First steps

4.1 Opening the box
DHH805-A is delivered inside an hard plastic case containing:

- a carrying bag made of anti-static polyester with removable and adjustable belt
- a pack of four type AA 1.5 V disposable alkaline batteries for use in safe areas only (AA alkaline batteries not supplied)
- a sealed pack of rechargeable NiMH battery for use in hazardous areas
- a universal AC power supply unit with four interchangeable plugs (UK, USA, Europe and Australia)
- two standard banana jacks
- a USB cable to connect DHH805-A to the PC
- a leadset for transmitter connection (1.5 mt. / 5 ft)
- a CD-Rom / DVD-Rom containing PC-Tool installation files, user's manual and HART® DD library
- an instruction sheet for DHH805-A PC connection
- a screwdriver

4.2 Preliminary inspection
Once opened the box, check the device for transport damage and check the packaging material for accessories. Before powering the DHH805-A on, it is necessary to remove the rubber shell and install one of the battery packs provided by tightening the screws located in the rear bottom of the Hand Held Communicator.

4.3 DHH805-A Start up procedures
To connect your DHH805 HART® Hand Held Terminal to the DHH805 PC-Tool please follow the following instructions:

1. Install the DHH805 PC-Tool from the DVD-Rom you have inside the device packaging: a driven installation procedure starts and all the needed actions are explained step by step.

Note.
Minimum system requirements for DHH805 PC-Tool software are:

**Hardware:**
- Intel Pentium® D 2.8 GHz or AMD Athlon™ 64 X2 4400+ processor
- Screen resolution of 1024x768 or greater
- Broadband Internet connection
- DVD-ROM reader

**Software:**
- Latest Windows XP, Windows 7 or Windows Vista Service Packs
- 1 gigabyte (GB) RAM (32-bit) for XP version or 1.5 gigabyte (GB) RAM (32-bit) for Windows 7 and Windows Vista.
- 200 megabytes (MB) to 2 gigabytes (GB) available hard disk space (32-bit)
- Microsoft NET Framework 3.5 or later

2. Unhook the elastic handle strap on the back of the device.
3. Remove the protective rubber shell from the strap
4. On the back of the device (see picture to left), release the battery pack fixing screws from the holes located at the bottom of the battery pack seat.
5. Install the rechargeable battery pack and tighten the fixing screws.
6. By inserting the provided DVD now and running the DHH805 Setup.exe, the DVD will walk you through steps 7-8, installing the program on your computer, and synching the device to the program.

Note. Operation of the DHH805 is only allowed in safe areas.
7. In the black cardboard box inside the DHH805 suitcase, you will find the battery charger and 4 power plug adapters. Select the adapter that is compatible with your AC power plug and snap it into place on the AC power connection.
8. Open the plastic cover found on the top side of the DHH805 and plug in the power cord of the battery charger and connect the hand terminal to the PC via the USB cable. After a few seconds, the backlight will come on indicating that the DHH805 has turned on.
9. A short message will be displayed on DHH805. Depress the bottom right-hand corner navigation key (On) and access the activation menu.

---

**Important.** Please use the NiMH battery pack only when in hazardous areas.
10. Continue to follow instructions on the computer screen until the activation screen appears.

11. To activate the DHH805 select “Via PC-Tool” or “Manually” in the activation menu on the display.

4 First steps

10. Continue to follow instructions on the computer screen until the activation screen appears.

11. To activate the DHH805 select “Via PC-Tool” or “Manually” in the activation menu on the display.

The selection of “Printed activation request form” allows user to fill in a dedicated information form. After accepting “ABB License Agreement” and “Remote Data Acquisition and Personal Data Collection” agreements (see paragraph 4.5 “Authorizations”), the PC-Tool generates a printable file which should be signed and returned via fax or e-mail (fax numbers and e-mail addresses available in Help > PC-Tool Help > Contact us).

By clicking on “Phone assisted activation instructions” a pop-up window will show four dedicated telephone numbers: a specialist will help users in activating the DHH805-A.

4.4 Activation procedure

4.4.1 Activation via PC-Tool

ABB DHH805-A can be easily activated via PC-Tool in two different ways: off-line and on-line. Please proceed to your preferred section.

Off-line activation

After connecting the DHH805-A to the PC-Tool as explained in the previous paragraph, the PC-Tool installer will check for internet connection availability. If no internet connections are available, you can click the “Activation” button that appears on PC-Tool homepage. The user will see a warning message (see figure 5) for starting the offline activation procedure. By flagging the “Off-line Activation” box, the user can click on “Printed activation request form” or follow the “Phone assisted activation instructions”.

After you receive the activation code, enter it by the following: Activation > Manually> Activation Code> Edit.

“Device activated successfully!” will appear when it is complete.

Note. When the DHH805 is synchronizing, it will display the message “synchronizing.” DHH805 will indicate “Connected” when it complete synchronizing.

If you choose “Manually” you must contact your designated ABB product manager listed in the gray box below. They will need the DHH805 tag.

Note. DHH805 tag can be found printed on the white cardboard packing box or on the DHH805 screen under Activation > Manually > DHH805 tag.

After activation, the DHH805 is ready to communicate with your HART® devices.

In order to connect the Hand-Held Terminal to the PC to manage DD files or configuration, it is necessary to synchronize them. To do this operation, select “Settings” on DHH805 main menu and confirm with the right navigation key “Select”. Scroll down to “Listening”, confirm with the right navigation key “Select” and refresh PC-Tool homepage clicking File > Home.
Figure 6: DHH805-A PC-Tool On-line activation

Once the form above has been populated, user has to proceed by clicking on the activation button on the top-right-hand corner. By accepting the “ABB License Agreement” and the “Remote Data Acquisition and Personal Data Collection” agreements, the device connected to the PC-Tool will be activated automatically: the activation code will be written inside the DHH805-A by the software itself.

Important. Please refer to DHH805 tag when making enquiries. DHH805 tag can be found on a pop-up window (see figure 6), on the cardboard packing and inside the DHH805-A navigation menu (Activation > Manually > DHH805 tag).

The Activation Code, once received, should be written inside the dedicated box (see figure 6) of the PC-Tool or keyed in on the DHH805-A (Activation > Manually > Activation Code)

Important. The activation code is free of charge and can be used only once per device.

4.4.2 Manual activation

Device activation procedure can be performed at any time manually. User needs to have the activation code and write it as it is (hyphens included) inside the dedicated entry of the DHH805-A navigation menu (Activation > Manually > Activation Code). PC-Tool allows user to write the activation code manually inside a dedicated window. User can get the code by contacting ABB product managers listed in the previous paragraphs. For accessing this activation panel (see figure 7) no internet connection has to be detected. Once activated, the DHH805-A is ready for DD management.

Figure 7: DHH805-A PC-Tool Off-line activation

4.5 Disclaimers

As mentioned in the previous paragraphs, user shall accept some terms in order to start using ABB DHH805-A.

Please read them carefully.

4.5.1 ABB S.p.A. END-USER LICENSE AGREEMENT FOR ABB SOFTWARE

IMPORTANT-READ CAREFULLY: This END-USER License Agreement (“EULA”) is a legal agreement between you (either an individual or a single entity) and ABB S.p.A. (“ABB”) for the ABB Software accompanying this EULA, which includes computer software and may include associated media, printed materials, and “online” or electronic documentation (“SOFTWARE PRODUCT” or “SOFTWARE”). By installing, copy or otherwise using the SOFTWARE PRODUCT, you agree to be bound by the terms of this EULA. If you do not agree to the terms of this EULA, discontinue installation, copy, or use of the SOFTWARE PRODUCT, destroy all copies and all component parts of the SOFTWARE PRODUCT, and promptly contact ABB for instructions on return of the SOFTWARE PRODUCT for a refund.

SOFTWARE PRODUCT LICENSE
The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties, as well as other applicable intellectual property laws and treaties. This is a License and not a “sale” of the SOFTWARE PRODUCT. ABB grants you a non-exclusive right to use this copy of the SOFTWARE PRODUCT.

APPLICABILITY
This EULA shall solely apply to the software accompanied with this license, and shall not be effective to convey rights in any other software.

GRANT OF LICENSE
Except as otherwise expressly provided in this EULA, you may only install and use one copy of the SOFTWARE PRODUCT on one computer system.

You may make a single back-up copy of the computer software portion of the SOFTWARE PRODUCT only for archival purposes.

LIMITATION OF LICENSE
You are only allowed to install/use it together with the DHH805-A Hart hand held configurator device provided to you inside this package.

Using the SOFTWARE PRODUCT on many computers by sharing all of or partial of the SOFTWARE PRODUCT.

Decompose the SOFTWARE PRODUCT and use it in the different computers or embody it into other software systems.

Delete the copyright notices on any copy of the SOFTWARE PRODUCT.

Disclose, transfer, provide, rent or otherwise make available in any form, SOFTWARE, or any portion thereof, to a third party without the prior consent of ABB.

Reverse engineer, decompile, or disassemble the SOFTWARE PRODUCT, except and only to the extent that such activity is expressly permitted by applicable law notwithstanding this limitation.
All rights not specifically granted under this EULA are reserved by ABB. All title and intellectual property rights in and to the SOFTWARE PRODUCT, the accompanying printed materials, and any copies of the SOFTWARE PRODUCT, including all rights in patents, copyrights, trademarks, and trade secrets applicable thereto, shall remain vested in ABB or its licensor.

Without prejudice to any other rights, ABB or its licensor may terminate your right to use the SOFTWARE PRODUCT under this EULA if you fail to comply with the terms and conditions of this EULA. Upon termination, you shall immediately stop using the SOFTWARE PRODUCT, remove all copies of the SOFTWARE PRODUCT and any related information from any electronic equipment under your control, and return to ABB the original disc media, the accompanying printed materials, and any material you have copied thereof within one month.

Within one month after the termination of this Agreement, you shall furnish to ABB a certificate certifying that through your best efforts, and to the best of your knowledge, the original and all copies, in whole or in part, in any form, of SOFTWARE PRODUCT have been destroyed.

ABB shall not be responsible for maintenance or field service of SOFTWARE under this EULA.

SOFTWARE is provided on an “AS IS” basis and without warranty of any kind, either express or implied, including but not limited to the implied warranties of merchantability, fitness for a particular purpose, or non infringement. The entire risk arising out of use or performance of the SOFTWARE PRODUCT remains with you. ABB does not warrant that the functions contained in the SOFTWARE will be uninterrupted or error free. ABB does not represent or warrant that SOFTWARE furnished hereunder is free of infringement of any third party patents, copyrights, or trade secrets.

ABB’S TOTAL LIABILITY HEREUNDER FOR DAMAGES OF ANY NATURE SHALL NOT EXCEED THE TOTAL PAYMENT MADE BY YOU FOR THE SOFTWARE. ABB SHALL NOT BE LIABLE FOR ANY SOFTWARE FAILURE RESULTING FROM ACCIDENT, ABUSE, MISAPPLICATION, OR MODIFICATION WITHOUT PERMISSION. IN NO EVENT SHALL ABB BE LIABLE FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING BUT NOT LIMITED TO DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY OTHER RECIPIARY LOSS) ARISING OUT OF THE USE OF, OR INABILITY TO USE, THE SOFTWARE PRODUCT, EVEN IF ABB HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Language Version Selection. You may be provided with a selection of language version for the SOFTWARE PRODUCT licensed under this EULA. If the SOFTWARE PRODUCT is included in more than one language version, you are licensed to use only one of the language versions provided. As part of the setup process for the upon selection, the language version selected by you will be set up on the computer system, and the language version(s) not selected by you will be automatically and permanently deleted from the hard disk of the computer system.

The SOFTWARE PRODUCT is licensed as a single product. Its component parts may not be separated for use on more than one computer.

The SOFTWARE PRODUCT is licensed as a single integrated product. The SOFTWARE PRODUCT may only be used with the HARDWARE as set forth in this EULA.

If the SOFTWARE PRODUCT is labeled as an upgrade, you must be properly licensed to use a product identified by ABB as being eligible for the upgrade in order to use the SOFTWARE PRODUCT ("Eligible Product"). For the purpose of upgrade product only, “HARDWARE” shall mean the computer system or computer system component with which you received the Eligible Product which came with the HARDWARE. You may use the resulting upgrade product only in accordance with the terms of this EULA and only with the HARDWARE.

All notices in connection with this EULA shall be in writing and shall be given by certified mail, return receipt requested, at the following address: ABB SpA., Via Statale, 113 LENNO (CO) ITALY.

This EULA shall be governed and interpreted by the ITALIAN laws. All disputes arising in connection with this EULA which cannot be settled amicably shall be resolved by arbitration through an ITALIAN court. The arbitration shall be final and binding upon both Parties. The arbitration fee (and costs) shall be born by the non-prevailing Party. In the course of arbitration, both Parties shall continue their respective contractual obligations except those matters under dispute arbitration.

This EULA sets forth the entire understanding between the parties with respect to the subject matter herein, and merges and supersedes all prior written herein, and understandings, express or implied, concerning such matters and, notwithstanding any provisions to the contrary, shall take precedence over any conflicting terms which may be contained in your purchase order acknowledgement form. This EULA states the entire obligations of ABB in connection with the SOFTWARE PRODUCT.
Important. Terms defined in the “End-user License Agreement for ABB Software” are to be accepted in order to start using ABB DHH805-A.

4.5.2 ABB S.p.A. Personal Data Handling Authorization

IMPORTANT- READ CAREFULLY:

The DHH805-A PC-Tool software allows you to register your device specifying your personal information as well as location, e-mail address and telephone number.

These information will be used by ABB to notify you about available firmware or software upgrades, known issues or available product enhancements.

As ABB aims to preserve the right to protect anybody’s personal data, we confirm that any kind of treatment will be according to common rules of correctness, lawfulness, transparency and protection of your rights and your privacy.

The treatment of all this data will be carried on by authorized personnel with the following procedures: Use of paper, computer managed archives and electronic data transmission.

Your personal data will never be transmitted to anybody outside ABB without your previous written authorization.

YES, I authorize ABB to collect and handle my data.
NO, I do not authorize ABB to collect and use my personal data.

4.5.3 ABB S.p.A. Data Acquisition and Handling Authorization

IMPORTANT- READ CAREFULLY:

In the philosophy of continuous product improvement, ABB SpA may collect data related to the functionality of your DHH805-A as well as the one of the DHH805-A PC-Tool Software.

Typical data collection may range from functionality errors detected by the on-board diagnostics to miss-interpretation errors with DDs or with some devices from specific manufacturers. To accomplish this, data related to the specific loaded DDs may be transmitted to our servers and being handled by ABB Research & Development, Service Teams as well as any other ABB division, Business Unit or department.

By accepting the agreement you expressly Authorize ABB to collect data from the DHH805-A HART® Hand Held terminal without any limitation.

Failing to accept the agreement will not allow ABB to detect if your specific device is not working correctly and notify you any possible available firmware update that may fix any eventual issue via the DHH805-A PC-Tool software.

YES, I authorize.
NO, I DO NOT authorize.
5 License upgrade

5.1 Overview
By default, DHH805-A communicates with ABB devices only. Model codification enables user to select a universal license allowing communication with all devices from all manufacturers. Universal communication capability for ABB-only devices can also be purchased separately.

5.2 License upgrade procedure
Once the device with “ABB only” license has been activated successfully, the license upgrade can be performed via PC-Tool or automatically.

Important. To have the PC-Tool communicating with the DHH805-A always select [Settings > Listening] on handheld main menu.

5.2.1 License upgrade via PC-Tool
As per activation, ABB PC-Tool will detect internet connection availability.

Off-line license upgrade procedure
To upgrade DHH805-A license when no internet connection is in place, PC-Tool will show a warning message (see figure 8). By flagging the “Off-line update” box, the user has now two possibilities: clicking on “Printed update request form” or following the “Phone assisted update instructions”.

Figure 8: DHH805-A PC-Tool Off-line license update
The selection of “Printed update request form” allows user to fill in a dedicated information form. After accepting “ABB License Agreement” as well as the “Remote Data Acquisition and Personal Data Collection” agreements (see paragraph 4.5 “Authorizations”), the PC-Tool generates a .pdf file which should be signed and returned via fax or e-mail (fax numbers and e-mail addresses available in Help > PC-Tool Help > Contact us).

By clicking on “Phone assisted update instructions” a pop-up window will show three dedicated telephone numbers: a specialist will help users in upgrading DHH805-A license.

Important. License upgrade is subject to Purchase Order to ABB. When performing the off-line procedure, please always mention our Order Acknowledgment number and device DHH805 tag.

Online license upgrade procedure
When operating online via PC-Tool, the upgrade panel here below is shown.

Figure 9: DHH805-A PC-Tool On-line upgrade panel
The Upgrade Code, once received, should be written inside the dedicated box (see figure 9) of the PC-Tool or keyed in on the DHH805-A (Upgrade > Manually > Upgrade Code)

Important. The upgrade code is can be used only once per device.

Important. Please read “ABB License Agreement” as well as the “Remote Data Acquisition and Personal Data Collection” agreements carefully before proceeding with license upgrade.

If the license upgrade procedure is successful, the upgrade code will be automatically written inside the device. Otherwise, the upgrade panel will show an error icon and a warning message will be displayed (see figure 10).

Figure 10: PC-Tool information message

5.2.2 Manual upgrade
License upgrade procedure can be performed later on manually. User needs to have the upgrade code and write it as it is (scores included) inside the dedicated entry of the DHH805-A navigation menu (Upgrade > Manually > Upgrade Code). Once the license has been upgraded from “ABB only” to “Full”, the DHH805-A will start communicating with all devices from all manufacturers.
6 General operations

6.1 Power options
DHH805-A general purpose unit can be powered for portable operation by four (4) AA alkaline batteries.

Note. AA alkaline batteries are not supplied.

The handheld configurator for Intrinsically Safe environments must be powered by approved rechargeable NiMH batteries (see the “Hazardous Area Use” section of this manual and the Intrinsically Safety Control Drawing shipped with every device for more information). AA alkaline and NiMH batteries are standard supplied items.

For bench top applications and download operations, the AC adapter (P/N EV3030 included with each device) is recommended. The AC adapter is only for use in safe areas.

6.2 Communication / AC adapter dongle
To connect DHH805-A to a PC use the USB cable provided inside the communicator case. See the “Updating DHH805-A Firmware and DDs” and “Documenting HART® Configurations with ABB PC-Tool” sections of this manual for more information on communications.

Important. DHH805-A can be connected to a PC only in safe areas. See the “Hazardous Area Use” section of this manual and the Intrinsic Safety Control Drawing in the Appendix of this manual for more information.

6.3 Navigating menus on the DHH805-A display
Several methods of navigating through the handheld communicator menus are available to the user for maximum convenience and utility.

— Soft keys: Use Up and Down soft keys to move cursor arrow to the desired menu option. Then use the Select soft key to accept the indicated choice. Soft key navigating tools are found throughout the DHH805-A main displays and HART® communication displays.

— Multi-page lists: Multi-page lists have a scroll bar symbol along the right hand side of the display indicating the existence of other information that can be viewed by using the Up and Down soft keys.

— Numbered item menus: All items displays have numbered menu lines when needed. This gives fast access directly to the desired menu line.

— Menu HOME key: To quickly retreat from any location to the main menu, hold for a few seconds the Delete / Help key. This will return the display to the initial main screen. The Home function will be disallowed if user is editing a parameter of if HART® task is in process (device navigation).

— Off-line menu HOME key: To quickly retreat from any location in the device menu to the initial menu screen, hold for a few seconds the Delete / Help key. This will return the display to the initial DHH805-A screen.

6.4 Turning the DHH805-A on
Use the dedicated ON key to power up the handheld communicator. A brief diagnostic runs while the ABB logo and DHH805-A firmware version is displayed. A message is displayed indicating the communicator is scanning for HART® devices within the defined address range (address equal to zero as default). The splash screens here below are displayed.

Figure 11: splash screens for Communication
After start up, the following scenarios are possible.

Figure 12: Device found
If the handheld communicator is connected to a HART® device with an address within the customized range (and there is sufficient loop resistance), DHH805-A immediately establishes HART® communication with the device. A scrolling display similar to the example above appears. The soft keys are then used to commission, re-configure, or maintain the connected device.

Figure 13: No devices within the address range
If no HART® device is connected, if a HART® device with address different from the defined one is connected, or if a connected device is not found due to wiring or loop resistance problem, the communicator will display the screen here above.
6.5 DH805-A settings

Handheld terminal menu features two sections as mentioned above. The following paragraphs aim to give a clear explanation of all functions.

6.5.1 Settings

This section contains different functions strictly related to the DH805-A that can be scrolled easily by using the up and down navigation keys. Submenus are:

- **Device List**: this section contains a list of all the Device Descriptor files uploaded on the SD card of DH805-A. This list is sorted by manufacturer and device type.

- **Polling**: used to set the address range to be scanned by the DH805-A during the first connection. Different methods are available: address 0, from 1 to 15, from 1 to 63 (maximum address fixed by HART® 7), and custom. By selecting custom on main polling menu, it is possible to define an address range different from the standard ones.

- **Listening**: is the submenu to be used when user wants to have the DH805-A communicating with the PC-Tool (firmware upgrade DD and configuration management).

- **Contrast**: this submenu allows contrast adjustments by using the left and right arrow keys. Contrast range goes from 0 to 100. Once edited, the customized value is stored and maintained until new parametrization.

- **Backlight**: by accessing to this submenu, it is possible to select “backlight behavior” (always enabled, disabled and on key press) and “backlight level” (from 0 to 3). In order to navigate through these functions use the up and down navigation keys, while to adjust the level push the left and right arrow keys.

- **Auto power off**: this part of the menu has to be used when the user wants to set the auto power off of the device. DH805-A powers off automatically by itself after 10 minutes from the last activity (communication with USB port or operation with the keyboard). All unsaved parameter changes will be discarded.

- **Password**: by entering this submenu, user can decide whether to protect the device or not. Password is an alphanumeric case sensitive string whose maximum length is 6 characters.

- **Log mode**: when enabled, this function allows to view on PC screen the DH805-A display. To view it, use the PC-Tool and click on Tools > Display HHT Screen.

- **Modem**: this function has to be used when user wants the DH805-A to be a modem HART®, transmitting the USB input as an HART® Physical Layer to the output.

- **DH805 tag**: this entry shows the device DH805 tag, useful when making enquiries to ABB.

- **Revision**: this submenu contains information about software, hardware and FPGA revision.

- **Memory info**: by navigating through this submenu, user will have a clear idea of memory status. Memory info shows the number of uploaded DDs and configurations, total and used memory, as well as free space on SD card.

- **Language**: DH805-A features a multi language menu. By editing this setting, users can choose between: English, Italian, German, French and Japanese. By editing this parameter, the user changes the visualization language of DD files as well (if one of the above languages is not supported, English will be used).

- **Upgrade**: by acting on this entry, it is possible to perform device upgrade both manually or via PC-Tool (please see chapter 5 “License upgrade” for further reference).

The following chart shows all of the default factory settings:

### Default factory settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polling</td>
<td>Address 0</td>
</tr>
<tr>
<td>Contrast</td>
<td>50</td>
</tr>
<tr>
<td>Backlight</td>
<td>On key press - level 2</td>
</tr>
<tr>
<td>Auto power off</td>
<td>Disabled</td>
</tr>
<tr>
<td>Language</td>
<td>English</td>
</tr>
</tbody>
</table>

6.5.2 Communication

Within this submenu, user can navigate the instrument managing DD files and configurations.

This section can be entered both online and offline.

When online, DH805-A polls the defined address range (address 0 by default) and loads the connected instrument DD file (see figures 10 and 11). User can navigate the instrument and explore DD structure. In online mode, it is possible to download and save instrument configurations and send the existing ones. Configurations will be named and saved with instrument tag automatically. If the file name is already existing, user can overwrite it.

In offline mode, the user navigates the SD card where all DD files are sorted by manufacturer and device type. Within this section user can edit, create, delete and clone configurations.

6.6 NiMh Battery Considerations

Batteries have a continuous run time with highest backlight level of about 16 hours. Without backlight, the average battery life is 100 hours. DH805-A keeps on working with empty battery signal for 2 hours.

In order to maximize batteries’ life, configure “Auto power off” and backlight “On key press”.

Though the power supply unit (supplied as standard) ensures the complete charge of the batteries, ABB recommends to occasionally discharge them completely. This will increase batteries’ performance over the year.

Battery pack needs to be fully charged almost once per year and it should be removed if DH805-A remains unused for long periods.

Keep the battery pack at temperatures below 35°C (95°F). This will reduce battery auto discharge.

Do not short-circuit batteries.

Apply anti-static precautions when handling the memory card or replacing the battery pack.
7 HART® communications

7.1 Overview
DHH805-A provides device specific HART® communication functions that allow the user to poll, configure, and maintain supported HART® field devices. The handheld communicator uses all Device Description commands to facilitate communication with a HART® field device.

You can use the DHH805-A to commission devices, for operational re-configuration needs, delete or maintain devices through analog and sensor trim adjustments, and many other features.

The DHH805-A will communicate with any HART® device through Universal and Common Practice Commands using the standard Generic DD (Device Description). However, it must have the DD for a specific HART® device installed before it can execute Device Specific Commands. You can consult the large and growing list of available DD at www.hartcomm.org for an up-to-date list of HART® devices for device specific support.

The list is found under Product Catalogue > All products. When HART® device support for new devices becomes available, the DHH805-A can be field updated using the dedicated PC-Tool.

7.2 HART® Commands
Three HART® command types are used by the DHH805-A to communicate with HART® field devices. First, Universal Commands are primarily used to identify a field device by its model number and tag number and to read process data from the device. This communication is referred to as “polling”.

The DHH805-A can poll any HART® Device. Second, Common Practice Commands are used for calibration and maintenance functions that are common to many devices. An example of this would be trims or adjustments for the devices’ analog outputs.

Third, Device Specific Commands are used to handle functions that are unique to a particular device or manufacturer. Examples of these commands include sensor zero, sensor trim, calibration curve characterization, density inputs required for calculations made by the HART® device, or other configuration functions unique to the specific device.

7.3 HART® Connections
HART® connections are made using two standard banana jacks (3/4” center) located at the top end of the handheld terminal (see figure 1). Polarity is not a concern for HART® connections, therefore, both jack collars are blue. ABB supplies a HART® lead kit complete with mini-grabber connections.

For low load loops (less than 250 Ω), a 250 Ω resistor may be needed in the loop to insure reliable HART® communications. Refer to the following diagram for connection details.

![HART® Connections Diagram](https://example.com/hart_connections.png)

1 Internal ground termination | 2 External ground termination | 3 DHH805-A | 4 Line load | 5 Power supply unit

Figure 14: DHH805-A wiring
## 7.4 Generic HART® Commands according to protocol Revision

DHH805 is able to communicate with HART® Revision 5, 6 and 7. Here below the list of Generic Commands according to the protocol revision.

<table>
<thead>
<tr>
<th>HART 5</th>
<th>HART 6</th>
<th>HART 7</th>
</tr>
</thead>
<tbody>
<tr>
<td>command: 0 READ UNIQUE IDENTIFIER</td>
<td>command: 0 READ UNIQUE IDENTIFIER</td>
<td>command: 0 READ UNIQUE IDENTIFIER</td>
</tr>
<tr>
<td>command: 1 READ PRIMARY VARIABLE</td>
<td>command: 1 READ PRIMARY VARIABLE</td>
<td>command: 1 READ PRIMARY VARIABLE</td>
</tr>
<tr>
<td>command: 2 READ P. V. CURRENT AND PERCENT OF RANGE</td>
<td>command: 2 READ P. V. CURRENT AND PERCENT OF RANGE</td>
<td>command: 2 READ LOOP CURRENT AND PERCENT OF RANGE</td>
</tr>
<tr>
<td>command: 3 READ DYNAMIC VARIABLES AND P. V. CURRENT</td>
<td>command: 3 READ DYNAMIC VARIABLES AND P. V. CURRENT</td>
<td>command: 3 READ DYNAMIC VARIABLES AND LOOP CURRENT</td>
</tr>
<tr>
<td>command: 6 WRITE POLLING ADDRESS</td>
<td>command: 6 WRITE POLLING ADDRESS</td>
<td>command: 6 WRITE POLLING ADDRESS</td>
</tr>
<tr>
<td>command: 11 READ UNIQUE IDENTIFIER ASSOCIATED WITH TAG</td>
<td>command: 11 READ UNIQUE IDENTIFIER ASSOCIATED WITH TAG</td>
<td>command: 11 READ UNIQUE IDENTIFIER ASSOCIATED WITH TAG</td>
</tr>
<tr>
<td>command: 12 READ MESSAGE</td>
<td>command: 12 READ MESSAGE</td>
<td>command: 12 READ MESSAGE</td>
</tr>
<tr>
<td>command: 13 READ TAG, DESCRIPTOR, DATE</td>
<td>command: 13 READ TAG, DESCRIPTOR, DATE</td>
<td>command: 13 READ TAG, DESCRIPTOR, DATE</td>
</tr>
<tr>
<td>command: 14 READ PRIMARY VARIABLE SENSOR INFORMATION</td>
<td>command: 14 READ PRIMARY VARIABLE SENSOR INFORMATION</td>
<td>command: 14 READ PRIMARY VARIABLE SENSOR INFORMATION</td>
</tr>
<tr>
<td>command: 15 READ PRIMARY VARIABLE OUTPUT INFORMATION</td>
<td>command: 15 READ PRIMARY VARIABLE OUTPUT INFORMATION</td>
<td>command: 15 READ PRIMARY VARIABLE OUTPUT INFORMATION</td>
</tr>
<tr>
<td>command: 16 READ FINAL ASSEMBLY NUMBER</td>
<td>command: 16 READ FINAL ASSEMBLY NUMBER</td>
<td>command: 16 READ FINAL ASSEMBLY NUMBER</td>
</tr>
<tr>
<td>command: 17 WRITE MESSAGE</td>
<td>command: 17 WRITE MESSAGE</td>
<td>command: 17 WRITE MESSAGE</td>
</tr>
<tr>
<td>command: 18 WRITE TAG, DESCRIPTOR, DATE</td>
<td>command: 18 WRITE TAG, DESCRIPTOR, DATE</td>
<td>command: 18 WRITE TAG, DESCRIPTOR, DATE</td>
</tr>
<tr>
<td>command: 19 WRITE FINAL ASSEMBLY NUMBER</td>
<td>command: 19 WRITE FINAL ASSEMBLY NUMBER</td>
<td>command: 19 WRITE FINAL ASSEMBLY NUMBER</td>
</tr>
<tr>
<td>command: 34 WRITE PV DAMPING VALUE</td>
<td>command: 34 WRITE PV DAMPING VALUE</td>
<td>command: 7 READ LOOP CONFIGURATION</td>
</tr>
<tr>
<td>command: 35 WRITE PRIMARY VARIABLE RANGE VALUES</td>
<td>command: 35 WRITE PRIMARY VARIABLE RANGE VALUES</td>
<td>command: 8 READ DYNAMIC VARIABLE CLASSIFICATIONS</td>
</tr>
<tr>
<td>command: 36 SET PRIMARY VARIABLE UPPER RANGE VALUE</td>
<td>command: 20 READ LONG TAG</td>
<td>command: 20 READ LONG TAG</td>
</tr>
<tr>
<td>command: 37 SET PRIMARY VARIABLE LOWER RANGE VALUE</td>
<td>command: 21 READ UNIQUE IDENTIFIER ASSOCIATED WITH LONG TAG</td>
<td>command: 21 READ UNIQUE IDENTIFIER ASSOCIATED WITH LONG TAG</td>
</tr>
<tr>
<td>command: 39 EEPROM CONTROL</td>
<td>command: 22 WRITE LONG TAG</td>
<td>command: 22 WRITE LONG TAG</td>
</tr>
<tr>
<td>command: 40 ENTER/EXIT FIXED PRIMARY VARIABLE CURRENT MODE</td>
<td>command: 34 WRITE PRIMARY VARIABLE DAMPING VALUE</td>
<td>command: 34 WRITE PRIMARY VARIABLE DAMPING VALUE</td>
</tr>
<tr>
<td>command: 41 PERFORM TX SELF TEST</td>
<td>command: 35 WRITE PRIMARY VARIABLE RANGE VALUE</td>
<td>command: 35 WRITE PRIMARY VARIABLE RANGE VALUE</td>
</tr>
<tr>
<td>command: 42 PERFORM DEVICE RESET</td>
<td>command: 43 SET PRIMARY VARIABLE TO ZERO</td>
<td>command: 43 SET PRIMARY VARIABLE TO ZERO</td>
</tr>
<tr>
<td>command: 44 WRITE PRIMARY VARIABLE UNITS</td>
<td>command: 44 WRITE PRIMARY VARIABLE UNITS</td>
<td>command: 44 WRITE PRIMARY VARIABLE UNITS</td>
</tr>
<tr>
<td>command: 45 TRIM PRIMARY VARIABLE CURRENT DAC ZERO</td>
<td>command: 45 TRIM PRIMARY VARIABLE CURRENT DAC ZERO</td>
<td>command: 45 TRIM PRIMARY VARIABLE CURRENT DAC ZERO</td>
</tr>
<tr>
<td>command: 46 TRIM PRIMARY VARIABLE CURRENT DAC GAIN</td>
<td>command: 46 TRIM PRIMARY VARIABLE CURRENT DAC GAIN</td>
<td>command: 46 TRIM PRIMARY VARIABLE CURRENT DAC GAIN</td>
</tr>
<tr>
<td>command: 108 WRITE BURST MODE COMMAND NUMBER</td>
<td>command: 38 RESET CONFIGURATION CHANGED FLAG</td>
<td>command: 38 RESET CONFIGURATION CHANGED FLAG</td>
</tr>
<tr>
<td>command: 109 BURST MODE CONTROL</td>
<td>command: 39 EEPROM CONTROL</td>
<td>command: 39 EEPROM CONTROL</td>
</tr>
<tr>
<td>command: 41 PERFORM TX SELF TEST</td>
<td>command: 40 ENTER/EXIT FIXED CURRENT MODE</td>
<td>command: 40 ENTER/EXIT FIXED CURRENT MODE</td>
</tr>
<tr>
<td>command: 42 PERFORM DEVICE RESET</td>
<td>command: 42 PERFORM DEVICE RESET</td>
<td>command: 42 PERFORM DEVICE RESET</td>
</tr>
</tbody>
</table>
7.5 HART® Communication / Online Mode

After power up, DHH805-A automatically detects if a field device is connected and attempts to establish HART communications; this is the factory default “Auto” poll function. When a device with address zero is found, the handheld terminal provides feedback to the user and starts the initial HART display for the connected device. See an example of Online Mode below.

![Figure 15: Device found](image1)

After polling, when no device connection is detected the DHH805-A shows an information screen (see figure 15).

![Figure 16: No device within the address range](image2)

7.6 Multidrop Poll (addresses 1 – 63)

To initiate a Multidrop Poll, select “Settings > Polling > Method Edit”. DHH805-A can poll different address ranges: address 0, addresses from 1 to 15 (HART 5), addresses from 1 to 63 (HART 6 and HART 7), or a customized range (as shown in figure 16). As mentioned in paragraph 6.5.1, default polling address is 0.

![Figure 17: Polling options](image3)

After selecting the desired address range to be polled, DHH805-A shows the list of all devices within that range sorted by tag (see figure 17).

7.7 Offline menu mode

After accessing offline mode from the communications menu, the Offline Menu allows the user to review DHH805-A stored device configuration list on the 8 Gb SD card. Configurations are sorted by manufacturer, device type, DD and device revision as well as to perform some functions on the selected DD. These operations are described here below.

![Figure 18: Device list after a multidrop polling](image4)

![Figure 19: Offline menu. Mandatory selection](image5)

![Figure 20: DD List on SD Card sorted by manufacturer](image6)

![Figure 21: Device type](image7)

![Figure 22: Saved DD files](image8)
7 HART® Communication

7.7.1 Configuration management - Edit
When navigating DD stored files, DHH805-A shows the screen here above (see figure 21 and 22). Once the Edit option has been selected, user gets access to offline configuration management. A progress bar indicates the percentage of configuration structure upload completion. As stated above, configurations are named, stored and sorted by instrument tag. DHH805-A can store up to 1000 device profiles (DD files) and up to 200 configurations. Lists can be scrolled by using the up/down navigation keys.

Figure 23: Configuration management

This screen lists all stored HART configurations by instrument tag number. The configurations stored enable fast commissioning of replacement devices, cloning of existing systems, or re-configuring for changes in process conditions or batch runs. Any configuration in the list can be sent to another HART device of the same manufacturer and model. The display can show 20 character tag numbers. Truncated tags are listed if more than 20 characters are used. Moving the cursor down to the tag of interest and pressing the Select soft key will provide a detailed information screen (see figure 24).

Figure 24: Configuration list

Figure 25: Editable configuration parameters in offline mode
This list features the Info icon. By pushing the Delete / Help button, user can read some detailed information about all editable parameters of the selected configuration (see figure 25).

Parameter editing is extremely simple. By selecting the Edit push button, user can modify and customize all configuration entries.

7.7.2 Configuration management - Create
Configurations can be created from the beginning by entering the second item on the list shown in figure 22. When user selects Create, DHH805-A shows the screen here below:

Figure 26: Information on editable configuration parameters

New configuration name will be instrument tag number, therefore it can feature a maximum length of 8 characters, otherwise an appropriate warning message will be displayed. The arrow icon in the bottom centre of the display indicates that the string is case sensitive. To enable/disable caps lock push the up navigation key. When the list of configurable parameters (see figure 24) appears, user can enter consistent values for all the parameters.

7.7.3 Configuration management - Delete
To delete configurations, select Delete under the Offline Configuration menu (figure 22). DHH805-A will show the configuration list (figure 23). Before deleting configurations, the handheld terminal will ask for confirmation and then gives a feedback about deletion outcome (as shown here below).

Figure 27: Configuration name

Figure 28: Deletion confirmation and feedback
7.7.4 Configuration management - Clone
Configuration cloning allows users to double a configuration stored on DHH805-A. After selecting the configuration to be cloned, the handheld terminal shows the same screen as per figure 26. Configuration is loaded, and DHH805-A redirects user automatically to the device type menu entry.

7.8 Online menu mode
Online Setup is the normal HART® communication mode. This mode enables communication with HART® field devices at the Universal, Common Practice, and Device Specific Command levels for full device setup and functionality.

Menus displayed for the connected device follow the HART® device manufacturer’s menu structure.

If user does not have the dedicated DD file, DHH805-A will ask if the user wants to use a generic DD (see figure 28).

Figure 29: Generic DD confirmation

7.9 Device status warning
Device status warning can be shown on the top-left-hand corner of the DHH805-A display (see figure 29).

Figure 30: Device status message
DHH805-A can display four different status:

- **LCF (Loop Current Fixed)**: the generated current is different from the reading of the instrument. This mismatch can occur when user is performing current output simulation or a polling address has been set.
- **MAL (Device Malfunctioning)**: the connected instrument is not working properly. User can find further details under DD diagnostics.
- **MSA (More Status Available)**: DD diagnostics is to be checked.
- **PRO (Process)**: handheld terminal shows this status message when device variables (process and non-process) are out of limits as well as when the loop current is saturated. More details can be found under DD diagnostics.

7.10 Save / send configuration functions
HART® device configurations may be saved to DHH805-A SD Card memory (8 Gb) or sent from the handheld terminal memory to a HART® device. These functions are useful for cloning a device configuration for use in another transmitter of the same configuration, for recording as-found and as-left configurations for later review, for returning HART® devices to previously used configurations, etc…

The Save / Send function may be accessed in one of two ways:

- Press the right navigation key (OK) when the device has been found (see figure 26). DHH805-A loads the DD file and user accesses the Online main menu. Save / Send commands are located within Configuration Handling.
- From the main screen appearing after activating the device (see figure 29 here below), select Settings > Device List. DHH805-A polls the address(es) and will return the same screen as per figure 28. Then proceed as mentioned above.
### 7.11 DD Structure

**Important.** To edit devices parameters navigate the below DD structures (here only 4 examples are mentioned).

DHH805 static menus are available in English, French, Italian, German and Japanese. DD file entries will always be in English.

#### 7.11.1 Device Setup - 266 Pressure Transmitter

<table>
<thead>
<tr>
<th>IDENTIFY</th>
<th>REMOTE SEALS</th>
</tr>
</thead>
<tbody>
<tr>
<td>DEVICE</td>
<td>QUANTITY</td>
</tr>
<tr>
<td></td>
<td>Number</td>
</tr>
<tr>
<td>ADDITIONAL DEVICE REVISION</td>
<td>LOW SIDE</td>
</tr>
<tr>
<td>Hardware Revision</td>
<td>Type</td>
</tr>
<tr>
<td>Software Revision</td>
<td>Diaphragm Material</td>
</tr>
<tr>
<td>MEASUREMENT POINT</td>
<td>Filling Fluid</td>
</tr>
<tr>
<td>Address</td>
<td>HIGH SIDE</td>
</tr>
<tr>
<td>Write Protection</td>
<td>Type</td>
</tr>
<tr>
<td>Communication Tag</td>
<td>Diaphragm Material</td>
</tr>
<tr>
<td>Date</td>
<td>Filling Fluid</td>
</tr>
<tr>
<td>Final Assembly Number</td>
<td>Hardware Revision</td>
</tr>
<tr>
<td>Descriptor</td>
<td>Software Revision</td>
</tr>
<tr>
<td>Message</td>
<td>ADDITIONAL INFORMATION</td>
</tr>
<tr>
<td>ADDITIONAL INFORMATION</td>
<td>Long Tag</td>
</tr>
<tr>
<td>Sensor Type</td>
<td>Low Side</td>
</tr>
<tr>
<td>Sensor Revision</td>
<td>Type</td>
</tr>
<tr>
<td>CONFIGURATION</td>
<td>PROCESS VARIABLE [P/DP]</td>
</tr>
<tr>
<td>COMMUNICATION TYPE</td>
<td>MEASURED VALUE</td>
</tr>
<tr>
<td>Burst Mode</td>
<td>Pressure</td>
</tr>
<tr>
<td>Burst Command</td>
<td>Output</td>
</tr>
<tr>
<td>PARAMETERIZE</td>
<td>PV % range</td>
</tr>
<tr>
<td>GENERAL</td>
<td>MEASURED VALUE</td>
</tr>
<tr>
<td>Local Operations</td>
<td>Pressure</td>
</tr>
<tr>
<td>Soft Write Protection</td>
<td>Output</td>
</tr>
<tr>
<td>SENSOR SET-UP</td>
<td>PV % range</td>
</tr>
<tr>
<td>P-DP SENSOR</td>
<td>MEASURED VALUE</td>
</tr>
<tr>
<td>Sensor Type</td>
<td>Pressure</td>
</tr>
<tr>
<td>Upper Sensor Limit</td>
<td>Output</td>
</tr>
<tr>
<td>Lower Sensor Limit</td>
<td>PV % range</td>
</tr>
<tr>
<td>Minimum Span</td>
<td>PV Bias</td>
</tr>
<tr>
<td>STATIC PRESS SENSOR</td>
<td>Set PV Val</td>
</tr>
<tr>
<td>Upper Sensor Limit</td>
<td>Set PV to Zero</td>
</tr>
<tr>
<td>Lower Sensor Limit</td>
<td>Bias Value</td>
</tr>
<tr>
<td>Minimum Span</td>
<td>PV Bias Reset</td>
</tr>
<tr>
<td>OPERATIONAL LIMITS</td>
<td>PARALLEL SHIFT</td>
</tr>
<tr>
<td>Max Temperature Limit</td>
<td>Parallel Shift</td>
</tr>
<tr>
<td>Min Temperature Limit</td>
<td>TRANSFER FUNCTION</td>
</tr>
<tr>
<td>Max Working Pressure</td>
<td>LINEARIZATION TYPE</td>
</tr>
<tr>
<td>UNIT</td>
<td>Linearization Type</td>
</tr>
<tr>
<td>Temperature Unit</td>
<td>SQUARE ROOT SETTING</td>
</tr>
<tr>
<td>UNIT</td>
<td>Lin.Sqrt Root Point [%]</td>
</tr>
<tr>
<td>Temperature Unit</td>
<td>Cut Off</td>
</tr>
<tr>
<td>Static Pressure Unit</td>
<td>OUTPUT [P/DP]</td>
</tr>
<tr>
<td>SENSOR MATERIALS</td>
<td>FILTER</td>
</tr>
<tr>
<td>BASIC SENSOR MATERIALS</td>
<td>Damping</td>
</tr>
<tr>
<td>Diaphragm Material</td>
<td>SCALING</td>
</tr>
<tr>
<td>Filling Fluid</td>
<td>Unit</td>
</tr>
<tr>
<td>GAUGE SENSOR</td>
<td>Custom Unit</td>
</tr>
<tr>
<td>Process Connection Material</td>
<td>Lower Range Value</td>
</tr>
<tr>
<td>PROCESS CONNECTION HIGH SIDE</td>
<td>Upper Range Value</td>
</tr>
<tr>
<td>Connection Type</td>
<td>HART MAPPING</td>
</tr>
<tr>
<td>Flange Material</td>
<td>PV is</td>
</tr>
<tr>
<td>O-Ring Material</td>
<td>SV is</td>
</tr>
<tr>
<td>Blanking Plug</td>
<td>TV is</td>
</tr>
<tr>
<td>PROCESS CONNECTION LOW SIDE</td>
<td>QV is</td>
</tr>
<tr>
<td>Connection Type</td>
<td>Change PV Mapping</td>
</tr>
<tr>
<td>Flange Material</td>
<td>Change SV Mapping</td>
</tr>
<tr>
<td>O-Ring Material</td>
<td>Change TV Mapping</td>
</tr>
<tr>
<td>Blanking Plug</td>
<td>Change QV Mapping</td>
</tr>
</tbody>
</table>
7 HART® Communication

STATIC PRESSURE
PROCESS VARIABLE
  MEASURED VALUE
    Static Pressure
    Output
    PV % range
  MEASURED VALUE
    Static Pressure
SCALING
  VALUE INPUT
    Static Pressure Unit
    Lower Range Value
    Upper Range Value
PROCESS PRESSURE TRANSFER
  Rerange 4-20mA
PV BIAS
  Static Pressure
  Set PV Val
  Set PV Zero
  Bias Value
  PV Bias Reset
PARALLEL SHIFT
  Parallel Shift
OUTPUT
  FILTER
    Damping
  SCALING
    Unit
    Custom Unit
    Lower Range Value
    Upper Range Value
CURRENT OUTPUT
  FAIL SAFE
    Current Fail Safe
    Fail Safe Level
CURRENT SATURATION LIMITS
  Low Saturation
  High Saturation
CURRENT ALARM LIMITS
  O/P during fault
  Low Alarm Value
  High Alarm Value
TOTALIZER
  INPUT SETTING
    Totalizer Status
    Totalizer Mode
  BATCH SETTING
    Count direction
    Preset Value
    Reload
  TOTALIZER 1
    Unit
    Conv.Factor
    Custom Unit
  TOTALIZER 2
    Unit
    Conv.Factor
    Custom Unit
DISPLAY
  GENERAL
    Display Revision
  GENERAL
    Display Revision
    Contrast
    Language
DISPLAY SETTING
  Display Mode
    Line 1 View
    Line 2 View
  Bargraph View
DISPLAY SCALING
  Linearization Type
  Unit
  Custom Unit
  Upper Range Value
  Lower Range Value
CALIBRATION
PRESURE SENSOR
  Cal Pressure
  Full trim
  Zero trim
  Integration Time
  Sensor Temperature
  Sensor Temperature Trimming
STATIC PRESSURE
  Cal Static Pres
  Full trim
  Zero trim
  Lo Trim
CURRENT OUTPUT
  D/A trim
SIMULATION
  Input Simulation
  Input Simulation
  Loop test
OPERATE
  Output
  Pressure
  Static Pressure
  Sensor Temperature
  Scaled Output
  Totalization 1
  Totalization 2
  Totalization Batch
DIAGNOSIS
DIAGNOSIS MONITORING
  Diag Simulation
ELECTRONICS
  Status group 2
  Status group 5
  Status group 2
  Status group 3
  Status group 4
  More Info
SENSOR/ACTUATORS
  Status group 2
  Status group 2
  Status group 0
  Status group 2
  More Info
  Status group 0
  Status group 0
INSTALLATION/START UP
  Status group 4
  Status group 3
  More Info
  Device status
  Status group 4
  More Info
  Status group 5
  More Info:
OPERATING CONDITIONS
Status group 4
More Info
Status group 5
More Info
PROCESS
Status group 4
Status group 0
Status group 0
Status group 4
Status group 0
More Info
Status group 3
Status group 4
More Info
SIMULATION
Diag Simulation
ELECTRONICS
Diagnosis Simulation Group1
Diagnosis Simulation Group3
Diagnosis Simulation Group1
Diagnosis Simulation Group1
Diagnosis Simulation Group2
Diagnosis Simulation Group3
SENSOR/ACTUATORS
Diagnosis Simulation Group2
Diagnosis Simulation Group0
Diagnosis Simulation Group1
Diagnosis Simulation Group4
Diagnosis Simulation Group4
Diagnosis Simulation Group0
Diagnosis Simulation Group0
INSTALLATION/START UP
Diagnosis Simulation Group3
Diagnosis Simulation Group4
Diagnosis Simulation Group4
Diagnosis Simulation Group3
Diagnosis Simulation Group3
OPERATING CONDITIONS
Diagnosis Simulation Group3
Diagnosis Simulation Group3
Diagnosis Simulation Group3
Diagnosis Simulation Group3
PROCESS
Diagnosis Simulation Group0
Diagnosis Simulation Group0
Diagnosis Simulation Group0
Diagnosis Simulation Group0
Diagnosis Simulation Group3
Diagnosis Simulation Group2
Diagnosis Simulation Group2
Diagnosis Simulation Group0
Diagnosis Simulation Group1
Diagnosis Simulation Group1
Diagnosis Simulation Group1
Diagnosis Simulation Group1
CONFIGURATION
ELECTRONICS
Diagnosis Masking Byte 2
Diagnosis Masking Byte 3
INSTALLATION/START UP
Diagnosis Masking Byte 4
OPERATING CONDITIONS
Diagnosis Masking Byte 4
Diagnosis Masking Byte 5
SENSOR/ACTUATORS
Diagnosis Masking Byte 2
Diagnosis Masking Byte 4
Diagnosis Masking Byte 0
Diagnosis Masking Byte 0
Diagnosis Masking Byte 0
Diagnosis Masking Byte 3
Diagnosis Masking Byte 4
Diagnosis Masking Byte 4
PILD
PILD MONITORING
PILD Execute
PILD Status
PILD Output
PILD TRAINING
Training Output
Training Time
Auto Retrain
PILD SETTING
Sensitivity
Detection Time
Max.Press.Deviation
Band Autotuning
Band Low
Band High
Affect PV
HISTORIC INFO
DEVICE
No. Power On
Total Working time
PRESSURE VARIABLE LOGGING
Min.Pressure Value
Max.Pressure Value
Reset
SENSOR TEMPERATURE LOGGING
Min.Temperature Value
Max.Temperature Value
Reset
STATIC PRESSURE LOGGING
Min.Static Pressure Value
Max.Static Pressure Value
Reset
EXTRAS
RESETS
RESET
Reset Device
Reset to User Sensor Trimming
Reset Configuration To Default
SAVINGS
Save as User Sensor Trimming
Save Configuration as Default
LOAD FACTORY SETTINGS
Reset Factory Sensor Trimming
Reset Factory Output Trimming
TOTALIZER
TOTALIZER PROTECTION
Totalizer Status
CHANGE PASSWORD
Totalizer Status
Change Password
RESET TOTALIZER
Reset Totalizer 1
Reset Totalizer 2
Reset Totalizer Batch

Important. DD structure changes according to instrument design (gauge, absolute or differential pressure measurement with or without one or two diaphragm seals).
7.11.2 Device Setup - TTX200 Temperature Transmitter

**IDENTIFY**
- Tag
- Poll addr
- Manufacturer
- Model
- Dev id
- Software rev
- Hardware rev
- Write protect
- Descriptor
- Message
- Date

**CONFIGURE**
**SENSOR**
- Select sensor probe type
- Sensor probe type
- Sensor wire number
- Sensor resistance two wire
- Sensor Upper Limit
- Sensor Lower Limit
- Sensor Min Span
- Select sensor probe type
- Sensor probe type
- Sensor CJC type
- Sensor CJC temperature unit
- Sensor CJC temperature
- Sensor Upper Limit
- Sensor Lower Limit
- Sensor Min Span

**PARAMETERIZE**
**SENSOR**
- Sensor probe type
- Sensor wire number
- Sensor resistance two wire
- Sensor Upper Limit
- Sensor Lower Limit
- Sensor Min Span
- Sensor probe type
- Sensor CJC type
- Sensor CJC temperature
- Sensor Upper Limit
- Sensor Lower Limit
- Sensor Min Span

**CURRENT OUTPUT**
- PV Unit
- Range (4mA)
- To (20mA)
- Damping
- Reaction on errors
- Underrange value
- Overrange value

**SIMULATE**
- Loop test

**CALIBRATE**
**SENSOR TRIM**
- One point trim
- Reset trim

**CURRENT OUTPUT TRIM**
- D/A trim

**EXTRA**
- Reset to factory

**OBSERVE**
**OBSERVE**
- PV % range
- Analog Value
- Sensor (PV)
- Electronics Temperature (SV)
- Electrical Input (TV)

**DIAGNOSE**
**DEVICE STATE**
- Device state

**APPLICATION**
- Application
- Application
- Application
- Application
- Application

**SENSOR**
- Sensor
- Sensor
- Sensor
- Sensor
- Sensor

**ELECTRONICS**
- Electronics
- Electronics
- Electronics
- Electronics
- Electronics

**Important.** DD structure changes according to instrument design.
### 7.11.3 Device Setup - FSM4000 Flow Transmitter

#### PROCESS VARIABLES
- **PV**
- **To>F**
- **Overflow F**
- **To<R**
- **Overflow R**
- **ToD**
- **Overflow D**

#### DIAG/SERVICE
- Loop test

#### DIAGNOSIS
- **ERRORS**
  - Errors 1
  - Errors 2
  - Error Memory 1
  - Error Memory 2
- **WARNINGS**
  - Warnings 1
  - Warnings 2
  - Warnings 3
  - Mains interrupt
- **STATUS**
  - Status 1
  - Status 2
  - Reset Error regist
  - Reset Conf.changed

#### EXTENDED DIAGNOSIS
- **EXT.DIAG ERR/WARN**
- **EXT.DIAG ERRORS**
  - Err.ext.Diag 1
  - Err.ext.Diag 2
  - Err.ext.Diag 3
  - Err.ext.Diag 4
- **EXT.DIAG WARNINGS**
  - Warn.ext.Diag 1
  - Warn.ext.Diag 2
  - Warn.ext.Diag 3
  - Warn.ext.Diag 4
- **EXT.DIAG REGISTER**
  - Reg.ext.Diag 1
  - Reg.ext.Diag 2
  - Reg.ext.Diag 3
  - Reg.ext.Diag 4
  - Reset

#### EXT.DIAG MODE
- **Wrk hrs Converter**
- **Wrk hrs Primary**

#### CURRENT
- **Coil current**
- **Coil voltage**
- **Coil resistance**
- **Coil temperature**
- **Coil isolation resistance**
- **DAC**
- **Electrode voltage E1**
- **Electrode voltage E2**
- **Electrode balance**
- **Linearity**
- **Signal noise ratio**

#### MODE
- **Coil current status**
- **Coil voltage status**
- **Coil resistance status**
- **Coil temperature status**
- **Coil isolation resistance status**
- **DAC status**
- **Electrode voltage E1 status**
- **Electrode voltage E2 status**
- **Electrode balance status**
- **Linearity status**
- **Signal noise ratio status**

#### EXT.DIAG HISTORY
- **COIL CURRENT**
  - Wrk hrs Converter
  - Wrk hrs Converter 1
  - Wrk hrs Converter 2
  - Wrk hrs Converter 3
  - Wrk hrs Converter 4
  - Wrk hrs Converter 5
  - Wrk hrs Converter 6
  - Wrk hrs Converter 7
  - Wrk hrs Converter 8
  - Wrk hrs Converter 9
  - Wrk hrs Primary
  - Wrk hrs Primary 1
  - Wrk hrs Primary 2
  - Wrk hrs Primary 3
  - Wrk hrs Primary 4
  - Wrk hrs Primary 5
  - Wrk hrs Primary 6
  - Wrk hrs Primary 7
  - Wrk hrs Primary 8
  - Wrk hrs Primary 9
  - Coil current
  - Coil current 1
  - Coil current 2
  - Coil current 3
  - Coil current 4
  - Coil current 5
  - Coil current 6
  - Coil current 7
  - Coil current 8
  - Coil current 9
  - Coil current min
  - Coil current max
  - Set to default

- **COIL VOLTAGE**
  - Wrk hrs Converter
  - Wrk hrs Converter 1
  - Wrk hrs Converter 2
  - Wrk hrs Converter 3
  - Wrk hrs Converter 4
  - Wrk hrs Converter 5
  - Wrk hrs Converter 6
  - Wrk hrs Converter 7
  - Wrk hrs Converter 8
  - Wrk hrs Converter 9
  - Wrk hrs Primary
  - Wrk hrs Primary 1
  - Wrk hrs Primary 2
  - Wrk hrs Primary 3
  - Wrk hrs Primary 4
  - Wrk hrs Primary 5
  - Wrk hrs Primary 6
  - Wrk hrs Primary 7
  - Wrk hrs Primary 8
  - Wrk hrs Primary 9
  - Coil voltage
  - Coil voltage 1
  - Coil voltage 2
  - Coil voltage 3
  - Coil voltage 4
  - Coil voltage 5
  - Coil voltage 6
  - Coil voltage 7
  - Coil voltage 8
  - Coil voltage 9
  - Coil voltage min
  - Coil voltage max
  - Set to default
### COIL RESISTANCE

<table>
<thead>
<tr>
<th>Wrk hrs Converter</th>
<th>Wrk hrs Converter 1</th>
<th>Wrk hrs Converter 2</th>
<th>Wrk hrs Converter 3</th>
<th>Wrk hrs Converter 4</th>
<th>Wrk hrs Converter 5</th>
<th>Wrk hrs Converter 6</th>
<th>Wrk hrs Converter 7</th>
<th>Wrk hrs Converter 8</th>
<th>Wrk hrs Converter 9</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Coil resistance
- Coil resistance 1
- Coil resistance 2
- Coil resistance 3
- Coil resistance 4
- Coil resistance 5
- Coil resistance 6
- Coil resistance 7
- Coil resistance 8
- Coil resistance 9
- Coil resistance min
- Coil resistance max

Set to default

### COIL ISOLATION RESISTANCE

<table>
<thead>
<tr>
<th>Wrk hrs Converter</th>
<th>Wrk hrs Converter 1</th>
<th>Wrk hrs Converter 2</th>
<th>Wrk hrs Converter 3</th>
<th>Wrk hrs Converter 4</th>
<th>Wrk hrs Converter 5</th>
<th>Wrk hrs Converter 6</th>
<th>Wrk hrs Converter 7</th>
<th>Wrk hrs Converter 8</th>
<th>Wrk hrs Converter 9</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Coil isolation resistance
- Coil isolation resistance 1
- Coil isolation resistance 2
- Coil isolation resistance 3
- Coil isolation resistance 4
- Coil isolation resistance 5
- Coil isolation resistance 6
- Coil isolation resistance 7
- Coil isolation resistance 8
- Coil isolation resistance 9
- Coil isolation resistance min
- Coil isolation resistance max

Set to default

### DAC

<table>
<thead>
<tr>
<th>Wrk hrs Converter</th>
<th>Wrk hrs Converter 1</th>
<th>Wrk hrs Converter 2</th>
<th>Wrk hrs Converter 3</th>
<th>Wrk hrs Converter 4</th>
<th>Wrk hrs Converter 5</th>
<th>Wrk hrs Converter 6</th>
<th>Wrk hrs Converter 7</th>
<th>Wrk hrs Converter 8</th>
<th>Wrk hrs Converter 9</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- DAC
- DAC 1
- DAC 2
- DAC 3
- DAC 4
- DAC 5
- DAC 6
- DAC 7
- DAC 8
- DAC 9
- DAC min
- DAC max

Set to default
<table>
<thead>
<tr>
<th>ELECTRODE VOLTAGE E1</th>
<th>ELECTRODE BALANCE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wrk hrs Converter</td>
<td>Wrk hrs Converter</td>
</tr>
<tr>
<td>Wrk hrs Converter 1</td>
<td>Wrk hrs Converter 1</td>
</tr>
<tr>
<td>Wrk hrs Converter 2</td>
<td>Wrk hrs Converter 2</td>
</tr>
<tr>
<td>Wrk hrs Converter 3</td>
<td>Wrk hrs Converter 3</td>
</tr>
<tr>
<td>Wrk hrs Converter 4</td>
<td>Wrk hrs Converter 4</td>
</tr>
<tr>
<td>Wrk hrs Converter 5</td>
<td>Wrk hrs Converter 5</td>
</tr>
<tr>
<td>Wrk hrs Converter 6</td>
<td>Wrk hrs Converter 6</td>
</tr>
<tr>
<td>Wrk hrs Converter 7</td>
<td>Wrk hrs Converter 7</td>
</tr>
<tr>
<td>Wrk hrs Converter 8</td>
<td>Wrk hrs Converter 8</td>
</tr>
<tr>
<td>Wrk hrs Converter 9</td>
<td>Wrk hrs Converter 9</td>
</tr>
<tr>
<td>Wrk hrs Primary</td>
<td>Wrk hrs Primary</td>
</tr>
<tr>
<td>Wrk hrs Primary 1</td>
<td>Wrk hrs Primary 1</td>
</tr>
<tr>
<td>Wrk hrs Primary 2</td>
<td>Wrk hrs Primary 2</td>
</tr>
<tr>
<td>Wrk hrs Primary 3</td>
<td>Wrk hrs Primary 3</td>
</tr>
<tr>
<td>Wrk hrs Primary 4</td>
<td>Wrk hrs Primary 4</td>
</tr>
<tr>
<td>Wrk hrs Primary 5</td>
<td>Wrk hrs Primary 5</td>
</tr>
<tr>
<td>Wrk hrs Primary 6</td>
<td>Wrk hrs Primary 6</td>
</tr>
<tr>
<td>Wrk hrs Primary 7</td>
<td>Wrk hrs Primary 7</td>
</tr>
<tr>
<td>Wrk hrs Primary 8</td>
<td>Wrk hrs Primary 8</td>
</tr>
<tr>
<td>Wrk hrs Primary 9</td>
<td>Wrk hrs Primary 9</td>
</tr>
<tr>
<td>Electrode voltage E1</td>
<td>Electrode balance</td>
</tr>
<tr>
<td>Electrode voltage E1 1</td>
<td>Electrode balance 1</td>
</tr>
<tr>
<td>Electrode voltage E1 2</td>
<td>Electrode balance 2</td>
</tr>
<tr>
<td>Electrode voltage E1 3</td>
<td>Electrode balance 3</td>
</tr>
<tr>
<td>Electrode voltage E1 4</td>
<td>Electrode balance 4</td>
</tr>
<tr>
<td>Electrode voltage E1 5</td>
<td>Electrode balance 5</td>
</tr>
<tr>
<td>Electrode voltage E1 6</td>
<td>Electrode balance 6</td>
</tr>
<tr>
<td>Electrode voltage E1 7</td>
<td>Electrode balance 7</td>
</tr>
<tr>
<td>Electrode voltage E1 8</td>
<td>Electrode balance 8</td>
</tr>
<tr>
<td>Electrode voltage E1 9</td>
<td>Electrode balance 9</td>
</tr>
<tr>
<td>Electrode voltage E1 min</td>
<td>Electrode balance min</td>
</tr>
<tr>
<td>Electrode voltage E1 max</td>
<td>Electrode balance max</td>
</tr>
<tr>
<td>Set to default</td>
<td>Set to default</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ELECTRODE VOLTAGE E2</th>
<th>LINEARITY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wrk hrs Converter</td>
<td>Wrk hrs Converter</td>
</tr>
<tr>
<td>Wrk hrs Converter 1</td>
<td>Wrk hrs Converter 1</td>
</tr>
<tr>
<td>Wrk hrs Converter 2</td>
<td>Wrk hrs Converter 2</td>
</tr>
<tr>
<td>Wrk hrs Converter 3</td>
<td>Wrk hrs Converter 3</td>
</tr>
<tr>
<td>Wrk hrs Converter 4</td>
<td>Wrk hrs Converter 4</td>
</tr>
<tr>
<td>Wrk hrs Converter 5</td>
<td>Wrk hrs Converter 5</td>
</tr>
<tr>
<td>Wrk hrs Converter 6</td>
<td>Wrk hrs Converter 6</td>
</tr>
<tr>
<td>Wrk hrs Converter 7</td>
<td>Wrk hrs Converter 7</td>
</tr>
<tr>
<td>Wrk hrs Converter 8</td>
<td>Wrk hrs Converter 8</td>
</tr>
<tr>
<td>Wrk hrs Converter 9</td>
<td>Wrk hrs Converter 9</td>
</tr>
<tr>
<td>Wrk hrs Primary</td>
<td>Wrk hrs Primary</td>
</tr>
<tr>
<td>Wrk hrs Primary 1</td>
<td>Wrk hrs Primary 1</td>
</tr>
<tr>
<td>Wrk hrs Primary 2</td>
<td>Wrk hrs Primary 2</td>
</tr>
<tr>
<td>Wrk hrs Primary 3</td>
<td>Wrk hrs Primary 3</td>
</tr>
<tr>
<td>Wrk hrs Primary 4</td>
<td>Wrk hrs Primary 4</td>
</tr>
<tr>
<td>Wrk hrs Primary 5</td>
<td>Wrk hrs Primary 5</td>
</tr>
<tr>
<td>Wrk hrs Primary 6</td>
<td>Wrk hrs Primary 6</td>
</tr>
<tr>
<td>Wrk hrs Primary 7</td>
<td>Wrk hrs Primary 7</td>
</tr>
<tr>
<td>Wrk hrs Primary 8</td>
<td>Wrk hrs Primary 8</td>
</tr>
<tr>
<td>Wrk hrs Primary 9</td>
<td>Wrk hrs Primary 9</td>
</tr>
<tr>
<td>Electrode voltage E2</td>
<td>Linearity</td>
</tr>
<tr>
<td>Electrode voltage E2 1</td>
<td>Linearity 1</td>
</tr>
<tr>
<td>Electrode voltage E2 2</td>
<td>Linearity 2</td>
</tr>
<tr>
<td>Electrode voltage E2 3</td>
<td>Linearity 3</td>
</tr>
<tr>
<td>Electrode voltage E2 4</td>
<td>Linearity 4</td>
</tr>
<tr>
<td>Electrode voltage E2 5</td>
<td>Linearity 5</td>
</tr>
<tr>
<td>Electrode voltage E2 6</td>
<td>Linearity 6</td>
</tr>
<tr>
<td>Electrode voltage E2 7</td>
<td>Linearity 7</td>
</tr>
<tr>
<td>Electrode voltage E2 8</td>
<td>Linearity 8</td>
</tr>
<tr>
<td>Electrode voltage E2 9</td>
<td>Linearity 9</td>
</tr>
<tr>
<td>Electrode voltage E2 min</td>
<td>Linearity min</td>
</tr>
<tr>
<td>Electrode voltage E2 max</td>
<td>Linearity max</td>
</tr>
<tr>
<td>Set to default</td>
<td>Set to default</td>
</tr>
</tbody>
</table>
SIGNAL NOISE RATIO
Wrk hrs Converter
Wrk hrs Converter 1
Wrk hrs Converter 2
Wrk hrs Converter 3
Wrk hrs Converter 4
Wrk hrs Converter 5
Wrk hrs Converter 6
Wrk hrs Converter 7
Wrk hrs Converter 8
Wrk hrs Converter 9
Wrk hrs Primary 1
Wrk hrs Primary 2
Wrk hrs Primary 3
Wrk hrs Primary 4
Wrk hrs Primary 5
Wrk hrs Primary 6
Wrk hrs Primary 7
Wrk hrs Primary 8
Wrk hrs Primary 9
Signal noise ratio
Signal noise ratio 1
Signal noise ratio 2
Signal noise ratio 3
Signal noise ratio 4
Signal noise ratio 5
Signal noise ratio 6
Signal noise ratio 7
Signal noise ratio 8
Signal noise ratio 9
Signal noise ratio min
Signal noise ratio max
Set to default
Set all to default

EXT.DIAG ADJUST
Coil temperature
Temperature offset
Reference resistance
Cable length
SPAN
Value Electr. Volt. E1
Angle Electr. Volt. E1
Value Electr. Volt. E2
Angle Electr. Volt. E2
ZERO
Value Electr. zero E1
Angle Electr. zero E1
Value Electr. zero E2
Angle Electr. zero E2
Transfer reference resistance
Transfer electrode zero

EXT.DIAG FINGERPRINT
FINGERPRINT P1 P2
Wrk hrs Converter
Wrk hrs Primary
CURRENT
Coil current
Coil voltage
Coil resistance
Coil temperature
Coil isolation resistance
DAC
Electrode voltage E1
Electrode voltage E2
Electrode balance
Linearity
Signal noise ratio
Wrk hrs Converter P1
Wrk hrs Primary P1

PRODUCT 1
Coil current P1
Coil voltage P1
Coil resistance P1
Coil temperature P1
Coil isolation resistance P1
DAC P1
Electrode voltage E1 P1
Electrode voltage E2 P1
Electrode balance P1
Linearity P1
Signal noise ratio P1
Copy current to p1
Wrk hrs Converter P2
Wrk hrs Primary P2

PRODUCT 2
Coil current P2
Coil voltage P2
Coil resistance P2
Coil temperature P2
Coil isolation resistance P2
DAC P2
Electrode voltage E1 P2
Electrode voltage E2 P2
Electrode balance P2
Linearity P2
Signal noise ratio P2
Copy current to p2
FINGERPRINT SU FAC
Wrk hrs Converter
Wrk hrs Primary
CURRENT
Coil current
Coil voltage
Coil resistance
Coil temperature
Coil isolation resistance
DAC
Electrode voltage E1
Electrode voltage E2
Electrode balance
Linearity
Signal noise ratio
Wrk hrs Converter SU
Wrk hrs Primary SU
START UP
Coil current
Coil voltage
Coil resistance
Coil temperature
Coil isolation resistance
DAC
Electrode voltage E1 SU
Electrode voltage E2 SU
Electrode balance SU
Linearity SU
Signal noise ratio SU
Copy current to start up
Wrk hrs Converter Fac
Wrk hrs Primary Fac
FACTORY
Coil current Fac
Coil voltage Fac
Coil resistance Fac
Coil temperature Fac
Coil isolation resistance Fac
DAC Fac
Electrode voltage E1 Fac
Electrode voltage E2 Fac
Electrode balance Fac
Linearity Fac
Signal noise ratio Fac
# 7 HART® Communication

## BASIC SETUP
- Qmax
- Unit Qmax
- Unit totalizer
- Damping
- Tag
- Descriptor
- Message
- Date

## DETAILED SETUP
### DEVICE INFO
- Poll.addr.
- Tag
- Descriptor
- Manufacturer
- Model
- Date
- Dev.id
- Order-Number
- Software rev
- Version
- Primary Tag
- Converter Tag
- Message

### OPERATING
- Metersize
- Cal-fact 10m/s
- Qmax
- Low flow cut off
- Contact output
- Contact input
- Pulse factor
- Edit Pulse Factor
- Pulse width
- Edit Pulse Width
- Damping

### TOTALIZER
- To>F
- Set Totl.forward
- To<R
- Set Totl.reverse
- ToD
- Set Totl.diff.
- Reset Totalizer

### UNITS
- Unit Qmax
- Unit totalizer

### SPECIAL UNIT
- Units name
- Unit factor
- Prog. Unit
- Density

### OPERATING CONFIG.
- Detector e.pipe
- Alarm e.pipe
- Iout at e.pipe
- EPD Mode
- Adj,EPD full pipe
- Adj,EPD empty pipe
- Threshold
- Operating mode
- Flow direction
- Flow indication
- Noise reduction
- SYSTEM ZERO
  - System zero
  - Auto.adjust.Sys.zero
- PS-Code

### DISPLAY MODE
- Display mode
- 1st line
- 2nd line
- 3rd line
- 4th line
- Language

## ALARMS
- Max. Alarm
- Min. Alarm
- Iout at Alarm
- Iout Low Alarm
- Iout High Alarm
- Alarm e.pipe
- Iout at e.pipe
- Contact output
- Error 3 mask
- Error 4 mask

## PRIMARY
- Span Adjust
- Zero Adjust
- Phase
- Reference voltage
- Order-Number
- Calib.Date
- Tester
- Testrig
- Cal-fact 10m/s
- Frequency Primary
- Type of Primary
- Metersize

### CONVERTER
- Span Adjust ->V
- Span Adjust <-R
- Span Adjust ->V
- Span Adjust <-R
- Span Adjust ->V
- Span Adjust <-R
- Zero Adjust
- Zero Adjust
- Zero Adjust
- Adjust Iout 4mA
- Adjust Iout 20mA
- Instrument No.

### FUNCTIONTEST
- Test Contact output
- Test Contact input
- Test Memory
- Test Pulse Output
- Test QSimulation
- Loop test

### REVIEW
- Model
- Distributor
- Metersize
- Cal-fact 10m/s
- Qmax
- PV Min span
- Unit totalizer
- Damping
- Pulse factor
- Pulse width
- Low flow cut off
- Operating mode
- Flow indication
- Flow direction
- AO Alarm typ
- Xfer fnctn
- Write protect
- Manufacturer
- Dev id
- Tag
- Descriptor
- Message
- Date
- Universal rev
- Fld dev rev
- Software rev
- Version
- Poll addr
- var-Num req preams
- var-PV
- var-AO1
- var-PV % range
- var-Qmax
7.11.4 EDP300 Positioner

DEVICE SETUP

IDENTIFY

DEVICE
Manufacturer
Device type
Device ID
Device serial no
Device revision
Universal rev

ADDITIONAL DEVICE REVISION
Hardware revision
Software revision

MEASUREMENT POINT
Poll addr
Write protect
Descriptor
Message
Long tag
Date
Tag
Final asmbly num

POSITIONER
Pneumatic type
Device options

EASY SET-UP

EASY SET-UP
Actuator type
Vent position
Pneumatic type
Display value
Engineering unit (Temperature)
Pressure unit
Engineering unit
Auto adjust mode
Easy setup

AUTO ADJUST
Auto adjust mode
Progress
Auto adjust status
Set auto adjust mode
Start auto adjust
Stop auto adjust

PARAMETERIZE

INPUT

SETPOINT RANGE
Setpoint range min
Setpoint range max
Setpoint damping ramp down
Setpoint damping ramp up
Setpoint filter
Setpoint Configuration

DIGITAL INPUT
Digital input function
Digital input logic
DI default setpoint
Digital Input Configuration

UNIVERSAL INPUT SCALING
True current (Input)

INPUT RANGE
Min
Max
Set input range

DAMPING
Damping ramp
Set damping ramp

CHARACTERISTIC CURVE
Input characteristic
Set input characteristic

USER CURVE
Load curve from device
Save curve to device

7 HART® Communication

XY VALUES

X0
X1
X2
X3
X4
X5
X6
X7

X8
X9
X10

Y0
Y1
Y2
Y3
Y4
Y5
Y6
Y7

Y8
Y9
Y10
Y11
Y12
Y13
Y14
Y15

Y16
Y17
Y18
Y19
Y20
Y21

ENGINEERING UNIT
Engineering unit
Set Eng unit

OUTPUT SCALING
Min
Max
Set output scaling
Calculated value (Output)

FEEDBACK
ANALOG FEEDBACK
FB current min
FB current max
FB characteristic
Alarm logic
Position feedback
Config Analog FB Signal

DIGITAL FEEDBACK
SWITCH 1
Switch 1 function
Switch 1 value
Switch 1 logic
Switch 1 active
Config SW 1
7 HART® Communication

**SWITCH 2**
- Switch 2 function
- Switch 2 value
- Switch 2 logic
- Switch 2 active

Config SW 2

**SWITCH 1**
- Switch 1 value
- Switch 1 active

Config SW 1

**CONTROL PARAMETER**

**CONTROL PARAMETER**
- KP Up
- KP Down
- TV Up
- TV Down
- Y Offset Up
- Y Offset Down

Dead band
- Dead band approach
- Dead band timeout
- Dead band control time

Zone
- Set control parameters
- Load from archive
- Save to archive

**CONTROL MODE**
- Control mode
- Set control mode

**MAINTENANCE COUNTER**
- Total travel counter limit
- Movement counter limit
- Min movement Value
- Min travel value

Set Maintenance counters limit

**VALVE PARAMETER**

END POSITION BEHAVIOUR 0%
- Tight shut [End Position 0%]
- Dead angle [End Position 0%]
- Control at 0%

Config End Position 0%

END POSITION BEHAVIOUR 100%
- Tight shut [End Position 100%]
- Dead angle [End Position 100%]
- Control at 100%

Config End Position 100%

**DEVICE SET-UP**

**BASIC SETTING**
- Vent position
- Actuator type
- Setpoint direction
- Setpoint characteristic curve

**USER CURVE**
- Load curve from device
- Save curve to device

**X/Y VALUES**
- X0
- X1
- X2
- X3
- X4
- X5
- X6
- X7
- X8
- X9
- X10
- Y0
- Y1
- Y2
- Y3
- Y4
- Y5
- Y6
- Y7
- Y8
- Y9
- Y10
- X11
- X12
- X13
- X14
- X15
- X16
- X17
- X18
- X19
- X20
- X21
- Y11
- Y12
- Y13
- Y14
- Y15
- Y16
- Y17
- Y18
- Y19
- Y20
- Y21

Config Basic setting

**VALVE RANGE**
- Valve lower range
- Valve upper range
- Set Valve range

**WORKING RANGE**
- Working lower range
- Working upper range
- Set Working range

**GENERAL**
- Write protection
- Squawk
CALIBRATION
PRESSURE SENSOR LIMITS
Supply pressure limit low
Supply pressure limit high
Set limits
MEASURED VALUES
Supply pressure
Pressure Y1
Pressure Y2
CALIBRATE TO ATMOSPHERE
Adjust all sensors
Calibrate supply pressure
Calibrate Y1 pressure
Calibrate Y2 pressure
Ventilate Y1 pressure
Ventilate Y2 pressure
Finish calibration
SIMULATION
UNIVERSAL INPUT
Universal input
Start simulation
Stop simulation
DIGITAL FEEDBACK
Switch Point 1
Simulate SW 1
Switch Point 2
Simulate SW 2
ANALOG FEEDBACK
Alarm via analog feedback
Simulate
ALARM OUTPUT
Alarm Output
Simulate
EXTRA
RESETS
Device reset
Factory Setting
Switch HART Protocol Rev
Configuration Flag Reset
Reset Travel counter
Reset Movement counter
Reset Alarm History
Reset diagnosis status
SPECIAL FUNCTION
Lock dev status
Lock function DI
Access channel
PROCESS VALUES
OBSERVE VALUES
OBSERVE VALUES
OBSERVE VALUES
OBSERVE VALUES
Position
Position status
Setpoint value
Setpoint status
Deviation
Setpoint
Current status
Pressure Y1
Pressure Y1 status
Pressure Y2
Pressure Y2 status
Differential pressure
Differential pressure status
Supply pressure
Temperature
Travel counter
Movement counter
True current (Input)
Calculated value (Output)
TREND VALUES
CHART VALUES
PRESSURE VALUES
OTHERS
BAR GRAPHS
BAR GRAPH (PROCESSES)
BAR GRAPH (PRESSURE)
BAR GRAPH (OTHERS)
ADJUST SET VALUES
ADJUST SET VALUES
RANGES
Valve lower range
Valve upper range
Working lower range
Working upper range
SETPOINT & POSITION
OTHERS
Setpoint [W]
Position [%]
Temperature
Device status
Setpoint
True current (Input)
Calculated value (Output)
Supply pressure
OPERATION MODE
Actual mode
Target mode
Manual Setpoint
Set target mode
DIAGNOSIS
DIAGNOSIS
MONITORING
MONITORING
DEVICE STATUS
Diag simulation status
Device status
STATUS BYTE 0
Status group 0
STATUS BYTE 1
Status group 1
STATUS BYTE 2
Status group 2
STATUS BYTE 3
Status group 3
STATUS BYTE 4
Status group 4
STATUS BYTE 5
Status group 5
SIMULATION
SIMULATION
SIMULATION
ON/OFF
Diag simulation status
Simulation on
Simulation off
SIMULATE BYTE 0
Byte 0
Simulate
SIMULATE BYTE 1
Byte 1
Simulate
SIMULATE BYTE 2
Byte 2
Simulate
SIMULATE BYTE 3
Byte 3
Simulate
SIMULATE BYTE 4
Byte 4
Simulate
SIMULATE BYTE 5
Byte 5
Simulate
**CONFIGURATION**

| CONFIGURE BYTE 0 | Byte 0 | Mask |
| CONFIGURE BYTE 1 | Byte 1 | Mask |
| CONFIGURE BYTE 2 | Byte 2 | Mask |
| CONFIGURE BYTE 3 | Byte 3 | Mask |
| CONFIGURE BYTE 4 | Byte 4 | Mask |
| CONFIGURE BYTE 5 | Byte 5 | Mask |

**SETTINGS**

<table>
<thead>
<tr>
<th>POSITIONING LOOP MONITORING</th>
<th>Dead band timeout</th>
<th>Determinated stroke time up</th>
<th>Determinated stroke time down</th>
<th>Set Position timeout time</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>FRICTION ALARM DETECTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>KP UP</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>KP DOWN</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Y OFFSET UP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limit low (Offset Up)</td>
</tr>
<tr>
<td>Limit high (Offset Up)</td>
</tr>
<tr>
<td>Set Offset Up Limits</td>
</tr>
<tr>
<td>Y Offset Up</td>
</tr>
<tr>
<td>Y Offset Up (Ref)</td>
</tr>
<tr>
<td>Set Y Offset Up (Ref)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Y OFFSET DOWN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limit low (Offset Dn)</td>
</tr>
<tr>
<td>Limit high (Offset Dn)</td>
</tr>
<tr>
<td>Set Offset Down Limits</td>
</tr>
<tr>
<td>Y Offset Down</td>
</tr>
<tr>
<td>Y Offset Down (Ref)</td>
</tr>
<tr>
<td>Set Y Offset Down (Ref)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>STICCTION ALARM DETECTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>TV UP</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>TV DOWN</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

**NE107 CONFIGURATION**

<table>
<thead>
<tr>
<th>SENSOR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position measurement Failure</td>
</tr>
<tr>
<td>Edit</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>OPERATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>OPERATION 1</td>
</tr>
<tr>
<td>Setpoint out of range</td>
</tr>
<tr>
<td>Controller inactive</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>Electronic temperature out of limits</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>Overpressure from supply</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>Supply pressure limit low exceeded</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>Supply pressure limit high exceeded</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>Pressure NV chip defect</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>OPERATION 2</td>
</tr>
<tr>
<td>Pressure hammer from supply</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>Analog output simulation active</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>Binary output simulation active</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>Fail safe active - via user</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>Binary input active</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>Analog output supply fault</td>
</tr>
<tr>
<td>Edit</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ACTUATOR</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACTUATOR GROUP 1</td>
</tr>
<tr>
<td>Valve blocked</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>Positioning timeout - Check valve maintenance</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>kp up exceeded</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>kp Down exceeded</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>Stroke counter limit exceeded</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>Travel counter limit exceeded</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>Leakage during operation</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>Leakage chamber 1</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>Leakage chamber 2</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>Leakage in actuator</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>ACTUATOR GROUP 2</td>
</tr>
<tr>
<td>Pressure NV Data defect</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>tv up exceeded</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>tv down exceeded</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>Y-Offset Up exceeded</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>Y-Offset Down exceeded</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>Friction limit exceeded</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>Stiction limit exceeded</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>Universal input out of range</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>Universal input limit exceeded</td>
</tr>
<tr>
<td>Edit</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>GENERAL SETTINGS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time latch</td>
</tr>
<tr>
<td>Set Time Latch</td>
</tr>
</tbody>
</table>

---

Handheld communicator Model DHH805-A
7 HART® Communication

ELECTRONICS
Setpoint failure electronics
Edit
Electronic temperature measurement failure
Edit
Configuration data failure
Edit
Electronics - NV chip defect
Edit
Non volatile data defect
Edit
Option module defect
Edit
Fail safe active - via device error
Edit
Pressure measurement defect
Edit

CONFIGURATION
Positioning unstable
Edit
Device not calibrated
Edit

PROCESS
Position out of travel range
Edit
Zero-Point displacement
Edit
Switchpoint 1 exceeded
Edit
Switchpoint 2 exceeded
Edit

ALARM MASK

ALARM MAPPING
Alarm Output
Edit

ANALOG FEEDBACK
Check function
Edit
Off specification
Edit
Maintenance
Edit
Failure
Edit

DIGITAL FEEDBACK
Switch 1
Edit
Switch 2
Edit

DRAG INDICATORS
Config time window

CONTROL DEVIATION
ENDLESS

DAYS
Min
Average
Max
Reset

HOURS
Min
Average
Max
Reset

SUPPLY PRESSURE
ENDLESS

DAYS
Min
Average
Max
Reset

HOURS
Min
Average
Max
Reset

DIFFERENCE PRESSURE
ENDLESS

DAYS
Min
Average
Max
Reset

HOURS
Min
Average
Max
Reset

UNIVERSAL INPUT
ENDLESS

DAYS
Min
Average
Max
Reset

HOURS
Min
Average
Max
Reset

TREND HISTOGRAM
Config time window

POSITIONING TIMEOUTS
ENDLESS

< 0 % [EL]
0 - 10 % [EL]
10 - 20 % [EL]
20 - 30 % [EL]
30 - 40 % [EL]
40 - 50 % [EL]
50 - 60 % [EL]
60 - 70 % [EL]
70 - 80 % [EL]
80 - 90 % [EL]
90 - 100 % [EL]
> 100 % [EL]
Reset endless
### DAYS
- **< 0 % [DAYS]**
- **0 - 10 % [DAYS]**
- **10 - 20 % [DAYS]**
- **20 - 30 % [DAYS]**
- **30 - 40 % [DAYS]**
- **40 - 50 % [DAYS]**
- **50 - 60 % [DAYS]**
- **60 - 70 % [DAYS]**
- **70 - 80 % [DAYS]**
- **80 - 90 % [DAYS]**
- **90 - 100 % [DAYS]**
- **> 100 % [DAYS]**

Reset days

### HOURS
- **< 0 % [HRS]**
- **0 - 10 % [HRS]**
- **10 - 20 % [HRS]**
- **20 - 30 % [HRS]**
- **30 - 40 % [HRS]**
- **40 - 50 % [HRS]**
- **50 - 60 % [HRS]**
- **60 - 70 % [HRS]**
- **70 - 80 % [HRS]**
- **80 - 90 % [HRS]**
- **90 - 100 % [HRS]**
- **> 100 % [HRS]**

Reset hours

### TREND

#### VALVE MOVEMENTS
- **ENDLESS**
  - **< 0 % [EL]**
  - **0 - 10 % [EL]**
  - **10 - 20 % [EL]**
  - **20 - 30 % [EL]**
  - **30 - 40 % [EL]**
  - **40 - 50 % [EL]**
  - **50 - 60 % [EL]**
  - **60 - 70 % [EL]**
  - **70 - 80 % [EL]**
  - **80 - 90 % [EL]**
  - **90 - 100 % [EL]**
  - **> 100 % [EL]**

Reset endless

#### DAYS
- **< 0 % [DAYS]**
- **0 - 10 % [DAYS]**
- **10 - 20 % [DAYS]**
- **20 - 30 % [DAYS]**
- **30 - 40 % [DAYS]**
- **40 - 50 % [DAYS]**
- **50 - 60 % [DAYS]**
- **60 - 70 % [DAYS]**
- **70 - 80 % [DAYS]**
- **80 - 90 % [DAYS]**
- **90 - 100 % [DAYS]**
- **> 100 % [DAYS]**

Reset days

#### HOURS
- **< 0 % [HRS]**
- **0 - 10 % [HRS]**
- **10 - 20 % [HRS]**
- **20 - 30 % [HRS]**
- **30 - 40 % [HRS]**
- **40 - 50 % [HRS]**
- **50 - 60 % [HRS]**
- **60 - 70 % [HRS]**
- **70 - 80 % [HRS]**
- **80 - 90 % [HRS]**
- **90 - 100 % [HRS]**
- **> 100 % [HRS]**

Reset hours

### MAIN USED VALVE POSITION

#### ENDLESS
- **< 0 % [EL]**
- **0 - 10 % [EL]**
- **10 - 20 % [EL]**
- **20 - 30 % [EL]**
- **30 - 40 % [EL]**
- **40 - 50 % [EL]**
- **50 - 60 % [EL]**
- **60 - 70 % [EL]**
- **70 - 80 % [EL]**
- **80 - 90 % [EL]**
- **90 - 100 % [EL]**
- **> 100 % [EL]**

Reset endless

#### DAYS
- **< 0 % [DAYS]**
- **0 - 10 % [DAYS]**
- **10 - 20 % [DAYS]**
- **20 - 30 % [DAYS]**
- **30 - 40 % [DAYS]**
- **40 - 50 % [DAYS]**
- **50 - 60 % [DAYS]**
- **60 - 70 % [DAYS]**
- **70 - 80 % [DAYS]**
- **80 - 90 % [DAYS]**
- **90 - 100 % [DAYS]**
- **> 100 % [DAYS]**

Reset days

#### HOURS
- **< 0 % [HRS]**
- **0 - 10 % [HRS]**
- **10 - 20 % [HRS]**
- **20 - 30 % [HRS]**
- **30 - 40 % [HRS]**
- **40 - 50 % [HRS]**
- **50 - 60 % [HRS]**
- **60 - 70 % [HRS]**
- **70 - 80 % [HRS]**
- **80 - 90 % [HRS]**
- **90 - 100 % [HRS]**
- **> 100 % [HRS]**

Reset hours

### TREND

#### VALVE CYCLES
- **ENDLESS**
  - **< 0 % [EL]**
  - **0 - 10 % [EL]**
  - **10 - 20 % [EL]**
  - **20 - 30 % [EL]**
  - **30 - 40 % [EL]**
  - **40 - 50 % [EL]**
  - **50 - 60 % [EL]**
  - **60 - 70 % [EL]**
  - **70 - 80 % [EL]**
  - **80 - 90 % [EL]**
  - **90 - 100 % [EL]**
  - **> 100 % [EL]**

Reset endless

#### DAYS
- **< 0 % [DAYS]**
- **0 - 10 % [DAYS]**
- **10 - 20 % [DAYS]**
- **20 - 30 % [DAYS]**
- **30 - 40 % [DAYS]**
- **40 - 50 % [DAYS]**
- **50 - 60 % [DAYS]**
- **60 - 70 % [DAYS]**
- **70 - 80 % [DAYS]**
- **80 - 90 % [DAYS]**
- **90 - 100 % [DAYS]**
- **> 100 % [DAYS]**

Reset days

#### HOURS
- **< 0 % [HRS]**
- **0 - 10 % [HRS]**
- **10 - 20 % [HRS]**
- **20 - 30 % [HRS]**
- **30 - 40 % [HRS]**
- **40 - 50 % [HRS]**
- **50 - 60 % [HRS]**
- **60 - 70 % [HRS]**
- **70 - 80 % [HRS]**
- **80 - 90 % [HRS]**
- **90 - 100 % [HRS]**
- **> 100 % [HRS]**

Reset hours
### HOURS

<table>
<thead>
<tr>
<th>Percentage</th>
<th>[HRS]</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 0 %</td>
<td></td>
</tr>
<tr>
<td>0 - 10 %</td>
<td>[HRS]</td>
</tr>
<tr>
<td>10 - 20 %</td>
<td>[HRS]</td>
</tr>
<tr>
<td>20 - 30 %</td>
<td>[HRS]</td>
</tr>
<tr>
<td>30 - 40 %</td>
<td>[HRS]</td>
</tr>
<tr>
<td>40 - 50 %</td>
<td>[HRS]</td>
</tr>
<tr>
<td>50 - 60 %</td>
<td>[HRS]</td>
</tr>
<tr>
<td>60 - 70 %</td>
<td>[HRS]</td>
</tr>
<tr>
<td>70 - 80 %</td>
<td>[HRS]</td>
</tr>
<tr>
<td>80 - 90 %</td>
<td>[HRS]</td>
</tr>
<tr>
<td>90 - 100 %</td>
<td>[HRS]</td>
</tr>
<tr>
<td>&gt; 100 %</td>
<td>[HRS]</td>
</tr>
</tbody>
</table>

Reset hours

### TREND

#### UNIVERSAL INPUT

#### ENDLESS

<table>
<thead>
<tr>
<th>Percentage</th>
<th>[EL]</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 0 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>0 - 10 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>10 - 20 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>20 - 30 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>30 - 40 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>40 - 50 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>50 - 60 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>60 - 70 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>70 - 80 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>80 - 90 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>90 - 100 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>&gt; 100 %</td>
<td>[EL]</td>
</tr>
</tbody>
</table>

Reset endless

### DAYS

<table>
<thead>
<tr>
<th>Percentage</th>
<th>[DAYS]</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 0 %</td>
<td>[DAYS]</td>
</tr>
<tr>
<td>0 - 10 %</td>
<td>[DAYS]</td>
</tr>
<tr>
<td>10 - 20 %</td>
<td>[DAYS]</td>
</tr>
<tr>
<td>20 - 30 %</td>
<td>[DAYS]</td>
</tr>
<tr>
<td>30 - 40 %</td>
<td>[DAYS]</td>
</tr>
<tr>
<td>40 - 50 %</td>
<td>[DAYS]</td>
</tr>
<tr>
<td>50 - 60 %</td>
<td>[DAYS]</td>
</tr>
<tr>
<td>60 - 70 %</td>
<td>[DAYS]</td>
</tr>
<tr>
<td>70 - 80 %</td>
<td>[DAYS]</td>
</tr>
<tr>
<td>80 - 90 %</td>
<td>[DAYS]</td>
</tr>
<tr>
<td>90 - 100 %</td>
<td>[DAYS]</td>
</tr>
<tr>
<td>&gt; 100 %</td>
<td>[DAYS]</td>
</tr>
</tbody>
</table>

Reset days

### TREND

#### AVERAGE CONTROL DEVIATION

#### ENDLESS

<table>
<thead>
<tr>
<th>Percentage</th>
<th>[EL]</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 0 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>0 - 10 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>10 - 20 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>20 - 30 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>30 - 40 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>40 - 50 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>50 - 60 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>60 - 70 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>70 - 80 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>80 - 90 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>90 - 100 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>&gt; 100 %</td>
<td>[EL]</td>
</tr>
</tbody>
</table>

Reset endless

### TREND

#### FRICTION

#### ENDLESS

<table>
<thead>
<tr>
<th>Percentage</th>
<th>[EL]</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 0 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>0 - 10 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>10 - 20 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>20 - 30 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>30 - 40 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>40 - 50 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>50 - 60 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>60 - 70 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>70 - 80 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>80 - 90 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>90 - 100 %</td>
<td>[EL]</td>
</tr>
<tr>
<td>&gt; 100 %</td>
<td>[EL]</td>
</tr>
</tbody>
</table>

Reset endless

### TREND

#### HOURS

<table>
<thead>
<tr>
<th>Percentage</th>
<th>[HRS]</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 0 %</td>
<td>[HRS]</td>
</tr>
<tr>
<td>0 - 10 %</td>
<td>[HRS]</td>
</tr>
<tr>
<td>10 - 20 %</td>
<td>[HRS]</td>
</tr>
<tr>
<td>20 - 30 %</td>
<td>[HRS]</td>
</tr>
<tr>
<td>30 - 40 %</td>
<td>[HRS]</td>
</tr>
<tr>
<td>40 - 50 %</td>
<td>[HRS]</td>
</tr>
<tr>
<td>50 - 60 %</td>
<td>[HRS]</td>
</tr>
<tr>
<td>60 - 70 %</td>
<td>[HRS]</td>
</tr>
<tr>
<td>70 - 80 %</td>
<td>[HRS]</td>
</tr>
<tr>
<td>80 - 90 %</td>
<td>[HRS]</td>
</tr>
<tr>
<td>90 - 100 %</td>
<td>[HRS]</td>
</tr>
<tr>
<td>&gt; 100 %</td>
<td>[HRS]</td>
</tr>
</tbody>
</table>

Reset hours

### TREND
7 HART® Communication

STICTION ENDLESS
- < 0 % [EL]
- 0 - 10 % [EL]
- 10 - 20 % [EL]
- 20 - 30 % [EL]
- 30 - 40 % [EL]
- 40 - 50 % [EL]
- 50 - 60 % [EL]
- 60 - 70 % [EL]
- 70 - 80 % [EL]
- 80 - 90 % [EL]
- 90 - 100 % [EL]
- > 100 % [EL]

Reset endless

DAYS
- < 0 % [DAYS]
- 0 - 10 % [DAYS]
- 10 - 20 % [DAYS]
- 20 - 30 % [DAYS]
- 30 - 40 % [DAYS]
- 40 - 50 % [DAYS]
- 50 - 60 % [DAYS]
- 60 - 70 % [DAYS]
- 70 - 80 % [DAYS]
- 80 - 90 % [DAYS]
- 90 - 100 % [DAYS]
- > 100 % [DAYS]

Reset days

HOURS
- < 0 % [HRS]
- 0 - 10 % [HRS]
- 10 - 20 % [HRS]
- 20 - 30 % [HRS]
- 30 - 40 % [HRS]
- 40 - 50 % [HRS]
- 50 - 60 % [HRS]
- 60 - 70 % [HRS]
- 70 - 80 % [HRS]
- 80 - 90 % [HRS]
- 90 - 100 % [HRS]
- > 100 % [HRS]

Reset hours

TREND

FRICITION STICTION SETTING

PRESSURE OUTPUT Y2
- Pressure Y2
- Activate/Deactivate Y2

FRICITION LIMITS
- Limit 0
- Limit 1
- Limit 2
- Limit 3
- Limit 4
- Limit 5
- Limit 6
- Limit 7
- Limit 8
- Limit 9
- Limit 10

Set limits

STICTION LIMITS
- Limit 0
- Limit 1
- Limit 2
- Limit 3
- Limit 4
- Limit 5
- Limit 6
- Limit 7
- Limit 8
- Limit 9
- Limit 10

Set limits

DATA AND COUNTERS

LOAD COUNTERS
- Travel counter
- Total travel counter limit
- Set Limit

MOVEMENT COUNTERS
- Movement counter
- Movement counter limit
- Set Limit

POWER DOWN CYCLES
- Power down counter

DATA
- PRODUCTION DATE
- Production date
- Production time

VALVE MOUNTING DATE
- Valve mounting date
- Valve mounting time
- Set valve mounting date

HOST DATE
- Host date
- Host time
- Set Host Time
- Total time since production
- Total time since valve mounted
- Total operating time

VALVE SEAT TEST
- ACCEPTABLE TOLERANCE
  - Min
  - Max
  - Set parameters
- ACCEPTABLE UAI TOLERANCE
  - Min
  - Max
  - Set parameters
  - Check UAI
  - Check/Uncheck UAI

VALVE SEAT TEST
- Diagnosis mode
- Progress
- Test status
- Test result
- Start test
- Stop test

LEAKAGE TEST
- Diagnosis mode
- Progress
- Test status
- Test result
- met-Start test
- met-Stop test

PARTIAL STROKE TEST
- met-Last test
- TEST INTERVAL
  - Start test every
  - met-Set test interval

VENT AMOUNT
- PS Vent amount
- met-Set vent amount

POSITIONING TIMEOUT
- Timeout value
- Dead Time
- met-Set parameters

TEST
- Partial stroke state
- Progress
- Test status
- met-Start test (Now)
- met-Stop test

VALVE SIGNATURE TEST

SETTINGS
- Steps
- met-Set Steps
TEST
Diagnosis mode
Progress
Test status
met-Start test
met-Stop test
GRAPH
   met-Get trend
   met-Save to archive
   met-Load from archive

SPEED OVER POSITION TEST
SETTINGS
   Air Capacity
   Scaling factor
   Y-offset up
   Y-offset down
   met-Set parameters

TEST
Diagnosis mode
Progress
Test status
met-Start test
met-Stop test
GRAPH
   met-Get trend
   met-Save to archive
   met-Load from archive

STEP RESPONSE TEST
SETTINGS
   Start position
   Stop position
   Interval
   met-Set parameters

TEST
Diagnosis mode
Progress
Test status
met-Start test
met-Stop test
GRAPH
   met-Get trend
   met-Save to archive
   met-Load from archive

**Important.** DD structure changes according to instrument design.

Repeated entries across all DD structure examples are shown for convenience only, when “Online” those entry will change according to manufacturer and instrument settings.
8 PC-Tool

8.1 Overview
DHH805-A needs the dedicated software called PC-Tool. Using this software, the user can manage Device Description files and configurations, upgrade license, update DHH805-A firmware, and monitor SD Card memory.

Note. SD Card memory status is also available under Settings > Memory info.

8.2 Installation procedure
Once the DVD has been inserted in the DVD-Rom reader, the driven installation procedure begins. Many PC configurations are checked and at the end PC-Tool software is installed. In case of unexpected errors, an intuitive troubleshooting section leads users to DHH805 and PC-Tool complete functioning.

Note. PC-Tool installer start autonomously thanks to an autorun file. In case your system administrator has disabled autorun functioning, browse DVD resources and click on DHH805 Setup.exe

8.3 PC-Tool homepage
DHH805-A PC-Tool is a user-friendly, intuitive software made by ABB. On the homepage, the status bar allows the user to know about whether the internet resources are correctly in place, whether the DHH805-A is connected to the PC-TOOL properly, and important device information, such as license type, device serial number, and update availability. See the below figure for locations of this information.

PC-Tool homepage features a menu bar composed by three tabs:

— **File**: contains basic software commands such as Home, Restart and Close
— **Tools**: features the most important commands such as License Upgrade, DD Manager, Configuration Manager, Display HHT Screen and Check for Updates.
— **Help**: gives users information about PC-Tool usage, error log, main software settings, and reference contacts.

8.4 Main tabs explanation

8.4.1 File
Under the File menu, the user can select three different commands:

— **Home**: refreshes PC-Tool homepage and performs software basic checks (internet resources availability, DHH805-A connection to the PC and identification, and firmware and software updates availability).
— **Restart**: re-launches PC-Tool program quickly, in the case of application misbehaving
— **Close**: stops the application, similar to the window close command in the top-right-hand corner.

8.4.2 Tools
This section contains the most important device management commands.

— **Upgrade license**: upgrades depending on the internet connection. It can be performed online or offline.
— **DD Manager**: enables user to upload DD files from PC to DHH805-A. Also, it is accessible directly from PC-Tool homepage.

8.3.1 PC-Tool homepage
DHH805-A PC-Tool is a user-friendly, intuitive software made by ABB. On the homepage, the status bar allows the user to know about whether the internet resources are correctly in place, whether the DHH805-A is connected to the PC-TOOL properly, and important device information, such as license type, device serial number, and update availability. See the below figure for locations of this information.

PC-Tool homepage features a menu bar composed by three tabs:

— **File**: contains basic software commands such as Home, Restart and Close
— **Tools**: features the most important commands such as License Upgrade, DD Manager, Configuration Manager, Display HHT Screen and Check for Updates.
— **Help**: gives users information about PC-Tool usage, error log, main software settings, and reference contacts.

8.4 Main tabs explanation

8.4.1 File
Under the File menu, the user can select three different commands:

— **Home**: refreshes PC-Tool homepage and performs software basic checks (internet resources availability, DHH805-A connection to the PC and identification, and firmware and software updates availability).
— **Restart**: re-launches PC-Tool program quickly, in the case of application misbehaving
— **Close**: stops the application, similar to the window close command in the top-right-hand corner.

8.4.2 Tools
This section contains the most important device management commands.

— **Upgrade license**: upgrades depending on the internet connection. It can be performed online or offline.
— **DD Manager**: enables user to upload DD files from PC to DHH805-A. Also, it is accessible directly from PC-Tool homepage.

1 Internet connection icon | 2 DHH805-A connection icon | 3 DHH805-A license type and DHH805 tag information icon | 4 Update icon

Figure 31: PC-Tool homepage

1 PC-Tool tree | 2 Transfer button | 3 Upload DDs to PC | 4 Recycle bin of left tree | 5 DHH805-A tree | 6 Upload button | 7 Recycle bin of right tree | 8 DHH805-A SD Card memory status with colour legend | 9 Tree sorting in descending order

Figure 32: PC-Tool DD manager
To upload a DD file from your PC:

- Click the browse button (7) and search for a manufacturer DD folder (do not select a single DD folder, it won’t be uploaded). The folder will then appear inside the left library tree (1).
- Select all DD files to be transferred to the DHH805-A tree (5) by using the transfer button (2). The files should appear under DHH805-A tree with a green flag.
- Upload to the SD Card memory by pushing the upload button (4). SD Card memory status is clearly shown by the pie diagram on the right (6). The colour legend below indicates the size of selected files, used and free memory space. Files can be deleted from DHH805-A or from the PC with the recycle bin button (3).

---

**Configurations Manager**: accessible directly from PC-Tool homepage, this command enables user to manage all configurations saved on DHH805-A and / or within PC-Tool. Bidirectional uploads / downloads are allowed.

---

**Display HHT Screen**: this function has been designed to allow users to see DHH805-A screen on the PC using the PC-Tool software. In order to perform this function,

Connect the hand-held terminal to the USB port of the PC and to the power supply.

Once the function has been selected, go to the DHH805-A main menu and edit the dedicated parameter (Settings > Log mode > Enable).

**Important.** Bidirectional communication (emulation) is not possible.

---

**Check for updates**: this panel allows user to see the running DHH805-A firmware and PC-Tool software revisions. As mentioned in the very first chapters, PC-Tool automatically detects updates once opened. A blinking icon in the lower right-hand corner and a warning message will inform the user of new software and/or firmware releases.

Select the manual update option to update firmware manually (if there is no internet service available (or) required firmware update forcefully).

---

**Check for updates**

Under the Help menu user can find details about:

- **PC-Tool Help**: the three submenus gives users’ suggestions and information about software functioning (PC-Tool Help), preliminary operations (Getting Started), and contact people (Contacts) for activation / upgrade license procedures as well as any other possible clarifications needed.

- **Log**: this entry is the functioning acquisition system allows users to monitor every PC-Tool action. In case of software malfunctioning, log should be sent to your ABB contact in order to have problems solved. The written log file can be found at C:\Data\DHH805\Log_Error and opened by using a common text editor.

---

**Configuration handling**

- Configurations can be saved on DHH805-A in offline mode.
- Once stored inside the SD card memory, they will appear under the DHH805-A configuration tree (5), and the memory pie diagram (6) will be updated accordingly.
- Configurations (named with instrument tag number) can be managed using the different transfer buttons (2, 3), deleted (4), and uploaded both on DHH805-A (if stored on the PC) and on PC memory (7, 8).
- Configuration saved on PC-Tool will appear under the PC configuration tree (1) and automatically saved at C:\Data\DHH805\Configurations.
- **Settings**: the figure below shows the settings panel. By accessing it, the user has the possibility of enabling the introduction tips (see figure 3) simply flagging the related box (1).

**Advanced Options** - Communication fields (2) should not be edited. By default, this panel is locked: to unlock press the dedicated button (3) and then save pressing the appropriate button (4). A confirmation icon (5) will appear.

![PC-Tool settings panel](image)

**Figure 35: PC-Tool DD manager**

- **Context menu**: Context menu available for items in the tree in the DD manager / Configuration by using the right click button

![Action drop-down box](image)

**Figure 36: Action drop-down box**

- **Copy checked to right** – Select any item and “Copy to right”. The checked items under the selected item will be moved to right side view (Vice versa for “Copy checked to left” option)

- **Check** – Select any item and check. The selected item and all of its sub items will be checked.

- **Uncheck** – Select any item and uncheck. The selected item and all of its sub items will be unchecked.

- **Copy to right** – Select any item and “Copy to right”. The selected item and all of its sub items will be moved to right side view (Vice versa for “Copy to left” option)

- **Expand** – Expand the selected item.

- **Collapse** – Collapse the selected item.

- **Contacts**: this window lists contact people for activation / license upgrade procedure assistance. Divided by geographical location, these contacts will also help users with DHH805-A and PC-Tool-related issues.

- **About registration**: this submenu has to be accessed when the user wants to modify his own contact details or change his acceptance to “ABB License Agreement” as well as “Remote Data Acquisition and Personal Data Collection” agreements (see paragraph 4.5 “Authorizations”)
### 8.5 Troubleshooting

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Solution</th>
</tr>
</thead>
</table>
| G001       | Close PC-Tool  
            | Shut down DHH805-A  
            | Disconnect and connect the USB cable to your PC |
| G002       | PC-Tool will be restarted automatically |
| G003       | PC-Tool will be restarted automatically |
| G004       | PC-Tool will be restarted automatically |
| G005       | PC-Tool will be restarted automatically |
| G006       | Close PC-Tool  
            | Shut down DHH805-A  
            | Disconnect and connect the USB cable to your PC |
| G007       | Close PC-Tool  
            | Shut down DHH805-A  
            | Disconnect and connect the USB cable to your PC |
| G008       | PC-Tool will be restarted automatically |
| G009       | PC-Tool will be restarted automatically |
| G010       | Please inform ABB about the corrupted DD or send the error log saved in DHH805->Log_Error folder |
| G011       | Please inform ABB about the corrupted DD or send the error log saved in DHH805->Log_Error folder |
| G012       | PC-Tool will be restarted automatically |
| G013       | PC-Tool will be restarted automatically |
| G014       | PC-Tool will be restarted automatically |
| G015       | PC-Tool will be restarted automatically |
| G016       | PC-Tool will be restarted automatically |
| G017       | Try again later |
| S001       | Close PC-Tool and shut down DHH805-A |
| S002       | Close PC-Tool and shut down DHH805-A |
| S003       | Close PC-Tool and shut down DHH805-A |
| S004       | Close PC-Tool  
            | Shut down DHH805-A  
            | If the problem persists, please extract SD card and format it |
| S005       | Close PC-Tool and shut down DHH805-A |
| S006       | Close PC-Tool and shut down DHH805-A |
| S007       | PC-Tool will be restarted automatically |
| S009       | Try to update later  
            | If problem persists, get in touch with your ABB reference contact |
| S010       | PC-Tool will be restarted automatically |
| S011       | PC-Tool will be restarted automatically |
| S012       | PC-Tool will be restarted automatically |
| S013       | PC-Tool will be restarted automatically |
| S015       | Close PC-Tool  
            | Shut down DHH805-A  
            | If problem persists, get in touch with your ABB reference contact |
| S003       | Close PC-Tool and shut down DHH805-A |
| S004       | Close PC-Tool and shut down DHH805-A |
| S005       | Close PC-Tool and shut down DHH805-A |
| S006       | Close PC-Tool and shut down DHH805-A |
| S007       | Close PC-Tool and shut down DHH805-A |
| S009       | Close PC-Tool and shut down DHH805-A |
| S010       | Close PC-Tool and shut down DHH805-A |
| S011       | Close PC-Tool and shut down DHH805-A |
| S012       | Close PC-Tool and shut down DHH805-A |
| S013       | Close PC-Tool and shut down DHH805-A |
| S015       | Close PC-Tool  
            | Shut down DHH805-A  
            | If problem persists, get in touch with your ABB reference contact |

If problem persists, get in touch with your ABB reference contact.
8.6 Prerequisites

8.6.1 Minimum System Requirements

**Hardware:**
- Intel Pentium® D 2.8 GHz or AMD Athlon™ 64 X2 4400+ processor
- Screen resolution of 1024 x 768 or greater
- Broadband Internet connection ¹
- DVD-ROM reader

**Software:**
- Latest Windows XP, Windows 7 or Windows Vista Service Packs
- 1 gigabyte (GB) RAM (32-bit) for XP version or 1.5 gigabyte (GB) RAM (32-bit) for Windows 7 and Windows Vista.
- 200 megabytes (MB) to 2 gigabytes (GB) available hard disk space (32-bit) ²
- Microsoft NET Framework 3.5 or later
- Adobe Reader 9.0 or later

8.6.2 Recommended System Requirements

**Hardware:**
- Intel® Core 2 Duo 2.4 GHz or AMD Athlon™ 64 X2 5600+ 2.8 GHz processor
- Broadband Internet connection ¹
- DVD-ROM reader

**Software:**
- Latest Windows® 7 Service Pack
- 4 gigabyte (GB) RAM (32-bit)
- 3 gigabytes (GB) available hard disk space (32-bit) ²

---

**Note.**

¹ Some wireless connections cannot be defined as “broadband internet connections”. Results with wireless connections may vary.

² Worse case: by importing the entire DD Library required hard disk space is more than 1 gigabyte (GB).

---

8.7 Further information

DHH805 PC-Tool: simply click on Help > PC-Tool Help.

Latest updates: updates are detected automatically by the software itself (blinking icon on the bottom right corner). In case you would like to verify if new software releases are available, click Tools > Check for update.

Technical support: to view all the support resources available, visit www.abb.com
9 Hazardous area considerations

9.1 Intrinsically safe operations

The DHH805-A HART Communicators is certified for intrinsically safe operations according to ATEX, IEC Ex, FMus, FMc and Inmetro.

Refer to the Intrinsic Safety Control Drawing in section 9.2 of this manual for more information.

The DHH805-A is delivered with an Intrinsic safety rechargeable battery pack, identified by the proper markings as well as a General purpose AA battery pack holder. The device running with the general purpose battery pack MUST NOT be used in hazardous areas. The DHH805-A with Intrinsically Safe certification can be identified by the specific label on rear of the battery pack of the unit. A sample of the Intrinsically Safe and general purpose labels are shown below for reference.

Note the following WARNINGS and REQUIREMENTS for Intrinsically Safe DHH models:

Substitution of components may impair Intrinsic Safety.

To prevent ignition of flammable or explosive atmospheres;

- Disconnect power before servicing
- DO NOT open the unit, including battery compartment, or attempt to service the unit when located in flammable or potentially explosive atmosphere. Remove to safe area.
- DO NOT use the general purpose AA battery pack in hazardous areas.
- DO NOT use the elastic band in hazardous areas.
- DO NOT replace batteries while in explosive or hazardous atmospheres
- DO NOT use any battery type other than those listed on the “Intrinsic Safe Control Document” found in Section 9.2 of this manual.
- DO NOT use USB connection above 40°C (104°F) ambient temperature.
- DO NOT recharge the unit when ambient temperature exceeds 35°C (95°F).
- DO NOT recharge the unit while the device is communicating with a field device
- ONLY use original SD memory card supplied from ABB (code EV3032), installation of a different SD card make the Hazardous area certification invalid.
9.2 Intrinsic Safe Control Document

9.2.1 Intrinsically safe FM Us and Canada Approved*

Intrinsically safe

FM us : CL 1 Div 1 Gr A B C D, T4
CL 1, Zone 0, IIC, T4

FM c : CL 1, Zone 0, IIC, T4

Entity Parameters
V max = 30 Vdc
I max = 215 mA
P max = 0.85 W
Ci = 0.04 uF
Li = 0 mH
Voc = 2.6 Vdc
Isc = 18 mA
Po = 61mW
Ca = 99 uF
La = 100mH

Hazardous classified location

Hazardous pressure transmitter

I.S. Barrier

Power Supply

load

250 ohm min.

Po Barrier < 0.7 Watts

Note: see paragraph 9.2.3 for Entity Concept

Note: For FMc Approval, use the FMc barriers according to Canadian Zone Concept
30 V max, 330 ohms min.
28 V max, 300 ohms min.
22 V max, 180 ohms min.

Warning. Use of the charger port is not allowed while the DHH805-A is connected or located in hazardous area

Warning. Use of the USB port is not allowed while the DHH805-A is connected or located in hazardous area

*Note. For FMc the equipment is approved only for the Canadian Zone Concept.
9.2.2 Non Incendive FM Us and Canada Approved

Hazardous classified location  Unclassified location

HART pressure transmitter

Power Supply

load

250 ohm min.

DHH805A

Non Incendive Parameters

V max = 42 Vdc
I max = 250 mA
C i = 0.04 uF
L i = 0 mH
V oc = 2.6 Vdc
I sc = 47 mA
C a = 99 uF
L a = 100 mH

Non Incendive

FM us : CL 1 Div 2 Gr A, B, C, D - T4
FM us : Suitable for Zone 2

Warning. Use of the charger port is not allowed while the DHH805-A is connected or located in hazardous area.

Warning. Use of the USB port is not allowed while the DHH805-A is connected or located in hazardous area.

Note: see paragraph 9.2.3 for Non Incendive Component Field Wiring
9.2.3 Entity and Non-Incendive component field wiring concepts

Entity Concept

Equipment which is FM approved for intrinsic safety may be connected to the barriers based on the ENTITY CONCEPT. This concept permits interconnections of approved transmitters, meters and other devices in combinations which have not been specifically examined by FM, provided that the agency’s criteria are met. The combination is then intrinsically safe if the entity concept is acceptable to the authority having jurisdiction over the installation.

The entity concept criteria are as follows:

— The intrinsically safe devices, other than barriers, must not be a source of power.
— The maximum voltage (Vmax) and current (Imax) which the device can receive and remain intrinsically safe, must be equal or greater than the voltage (Voc or Vt) and current (Isc or It) which can be delivered by the barrier.
— The sum of the maximum unprotected capacitance (Ci) for each intrinsically device and the interconnecting wiring must be less than capacitance (Ca) which can be safely connected to the barrier.
— The sum of the maximum unprotected inductance (Li) for each intrinsically device and the interconnecting wiring must be less than the inductance (La) which can be safely connected to the barrier.
— The maximum entity parameters Vmax, Imax, Ci, and Li for the hand held communicator model DHH805A are listed in paragraph 9.2.1 of this document.
— The entity parameters Voc or Vt, Isc or It, Ca and La for barriers are provided by the barrier manufacturer.

Non Incendive Component Field Wiring concepts

The Non-Incendive field wiring concept is very similar to the entity concept except it allows devices approved with Non-Incendive Component Field Wiring parameters to be installed in Division 2 hazardous classified location when connected to the appropriate sources of power provided that the appropriate criteria are met. The combination is then safe if the concept is acceptable to the authority having jurisdiction over the installation.

The criteria are as follows:

— There must be only one source of power. The source may be an intrinsic safety barrier or it may be a device marked with Non-Incendive Component Field Wiring parameters suitable for connection to Non-Incendive circuit components located in zone 2 hazardous location.
— The maximum voltage (Vmax) and current (Imax) which the device can receive and remain Non-Incendive, must be equal to or greater than the voltage (Voc or Vt) and current (Isc or It) which can be delivered by the source of power.
— The sum of the maximum unprotected capacitance (Ci) for each device and the interconnecting wiring must be less than the capacitance (Ca) which can be safely connected to the source of power.
— The sum of the maximum unprotected inductance (Li) for each device and the interconnecting wiring must be less than the inductance (La) which can be safely connected to the source of power.
— The Non-Incendive Components Field Wiring parameters Vmax, Imax, Ci, Li for the Hand Held Communicator model DHH805A are listed in paragraph 9.2.2.
— The parameters Voc or Vt, Isc or It, Ca and La for the source of power are provided by the manufacturer of that equipment.
**TROUBLE SHEET**

**WARRANTY REPAIR** □ **REPAIR ORDER** □

| Rejection or discrepancy Reports | copy attached □ | not available □ |

- **IDENTIFICATION**
  - Customer
  - Purchase order No
  - Plant
  - Name of person to contact
  - Instrument Tag No
  - Model
  - Serial Number

- **OPERATING CONDITIONS**
  Specify location, environmental conditions, type of service and approximate number of operating hours or date of installation if known

- **REASON FOR RETURN**

- **DANGEROUS FLUIDS**
  In case of toxic or otherwise dangerous fluid, please attach the relevant Material Safety Data Sheet

Trouble found during. | Installation | Commissioning | Maintenance |
---------------------|--------------|--------------|-------------|
                     | At start up  | On service   |             |

Shipping information for the return of the equipment

Material returned for factory repair should be sent to the nearest ABB Service Center; transportation charges prepaid by the Purchaser

Please enclose this sheet duty completed to cover letter and packing list

Date ________________ Signature ________________ Originator ________________

ABB S.p.A
Process Automation Division
Sales Office: Via Statale, 113 - 22016 Lenno (CO) Italy
Tel. +39 0344 58 111
Fax +39 0344 56 278
e-mail: abb.instrumentation@it.abb.com
RETURN REPORT – No.: __________

*) Please always fill in. Otherwise the case will not be handled as return

CONTROL OF SUBSTANCES HAZARDOUS TO HEALTH (C.O.S.H.H.)

Decontamination declaration - EQUIPMENT RETURNED FOR REPAIR, CALIBRATION OR CREDIT

From


Description

Return authorization no.

Model number

Serial number

A) The above equipment has not been in contact with any material which is hazardous to health.

B) The above equipment has been in contact with the material(s) noted below but that it has now been completely de-contaminated and is now safe to handle and dismantle without any special precautions. Material(s) which have been in contact with this equipment:

C) If A) or B) are not applicable full instructions for the safe handling of this equipment for disposal must be supplied.

Please delete A), B) or C) above as applicable, complete the signature section below, then send the completed declaration either with the returned items, or by fax for the attention of the Calibration & Repair Centre.

Note – no action to examine or repair equipment will be undertaken until a valid COSHH declaration has been received, completed by an authorized officer of the end user company.

Signed

Name

Position

Date

ABB S.p.A
Process Automation Division
Uffici Commerciali / Sales Office:
Via Statale, 113 - 22016 Lenno (CO) Italy
Tel. +39 0344 58 111
Fax +39 0344 56 278
e-mail: abb.instrumentation@it.abb.com
EC-Declaration of Conformity

We, ABB SpA – ABB PA Division, Business Unit Measurement Products, Via Statale 113, 22016 Lenno (Como) Italy, declare that the:

DHH805A Hand Held Communicator

are in conformity with the Council Directive 94/9/EC of 23 March 1994 and is designed and constructed in compliance with the following standards:

- EN 60079-0 : 2009
- EN 60079-11 : 2012
- EN 60079-26 : 2007

EC- Type Examination Certificate : ZEML 11 ATEX 0476X
Certified by : ZELM
Identification number : 0820
Address : Siekgraben 56, D-38124 Braunschweig Germany

Notified Body entrusted with the surveillance

Name : CESI
Identification number : 0722
Address : Via Rubattino 54, 20134 Milano Italy

Lenno 08/08/2012

ABB SpA – ABB PA Division
Business Unit Measurement Product

[Signature]

Walter Volo
Certification Manager
EC DECLARATION OF CONFORMITY

We: ABB S.p.A. – ABB PA Division
Business Unit Measurement Products
Via Statale, 113
22016 Lenno (Como)
Italy

Declare that the:

DHH805A Hand Held Communicator

are in conformity with the following standards:

EN 61326-1 (2006) Electrical equipment for measurement, control and laboratory use
EMC requirements. Part 1 : General requirements

EN 61326-2-2 (2006) Electrical equipment for measurement, control and laboratory use –
EMC requirements – Part 2-2 : Particular requirements – Test
configurations, operational conditions and performance criteria for
portable test, measuring and monitoring equipment used in low-
voltage distribution systems.

following the provisions of the EMC Directive 2004/108/EC.

ABB S.p.A. – ABB PA Division
Business unit Measurement Products

Eugenio Volonterio
Technical Director
Lenno, 08th August 2012
Intentionally blank
Products and customer support

ABB’s portfolio for valve automation:
- Continuous electrical actuators and pneumatic actuators
- Electro-pneumatic, pneumatic, and digital positioners
- I/P signal converters

ABB’s pressure measurement:
- Absolute, gauge and differential pressure transmitters
- IEC 61508 SIL2/3 certified pressure transmitters and switches
- Multivariable transmitters
- Interface level/density transmitters
- Pressure measurement remote seals
- Pressure measurement accessories
- Pneumatic pressure transmitters

ABB’s temperature measurement:
- Universal temperature sensors
- High-temperature sensors
- Temperature sensors for sanitary applications
- Mineral isolated temperature sensors
- Thermowells
- Temperature transmitters
- IEC 61508 SIL2/3 certified temperature sensors and transmitters

ABB’s portfolio of recorders and controllers:
- Process controllers and indicators
- Videographic recorders
- Paper chart recorders
- Field mountable indicators and controllers

ABB’s portfolio of level measurement:
- Magnetic level gauges
- Magnetostrictive and guided wave radar level transmitters
- Laser and scanner level transmitters
- Ultrasonic, capacitance and vibrating fork level transmitters and switches
- Rotating paddle and thermal dispersion level switches
- IEC 61508 SIL2/3 certified level transmitters

ABB’s portfolio of device management:
- Fieldbus and wireless solutions
- Scalable asset & device management
- Asset vision software
- Mobility handhelds

Customer support
We provide a comprehensive after sales service via a Worldwide Service Organization.
Contact one of the following offices for details on your nearest Service and Repair Centre.

ABB S.p.A.
Via Statale 113,
22016 Lenno (Co) – Italy
Tel: +39 0344 58111
Fax: +39 0344 56278

ABB Automation Product GmbH
Schillerstrasse 72
D-32425 Minden – Germany
Tel: +49 551 905534
Fax: +49 551 905555

ABB Inc.
125 E. County Line Road
Warminster, PA 18974 – USA
Tel: +1 215 6746000
Fax: +1 215 6747183

ABB Inc.
3450 Harvester Road
Burlington, Ontario L7N 3W5 – Canada
Tel: +1 905 6810565
Fax: +1 905 6812810

ABB Ltd.
32 Industrial Area, NIT,
Faridabad - 121 001, Haryana – India
Tel: +91 129 2448300
Fax: +91 129 2440622

ABB Engineering (Shanghai) Ltd.
No.5, Lane 369, Chuangye Rd., Pudong District,
Shanghai 201319 - P.R. China
Tel: +86 21 6105 6666
Fax +86 21 6105 6677

Client Warranty
Prior to installation, the equipment referred to in this manual must be stored in a clean, dry environment, in accordance with the Company’s published specification. Periodic checks must be made on the equipment’s condition. In the event of a failure under warranty, the following documentation must be provided as substantiation:

- A listing evidencing process operation and alarm logs at time of failure.
- Copies of all storage, installation, operating and maintenance records relating to the alleged faulty unit.